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مفاهیم پایگاه داده و آشنایی با نرم افزار پایگاه داده ها-  1 
مفاهیم کلیدی پایگاه داده ها- 1.1 
آشنایی با پایگاه داده ها- 1.1.1 

مجمواعه سازماندهی شده از اطلاعات مرتبط به هم در مههورد یههک یهها چنههد موضههوع را پایگههاه داده یهها بانههک اطلاعههاتی

می گویند.

اگر لیستی از اطلاعات کارمندان یک شرکت که شامل شناسه کارمند، نام، نههام خههانوادگی، دپارتمههان را تهیههه نمههاییم،

در واقع یک بانک اطلاعاتی ساده تهیه کرده ایم.

لیست تهیه شده را می توانیم در نرم افزارهایی مانند واژه پرداز یا صفحه گسترده وارد کنیم ولی این نرم افزارها، نرم افههزار

بانک اطلاعاتی محسوب نمی شوند زیرا امکانات و ویژگی های یک نرم افزار بانک اطلاعاتی را ندارند.

یک نرم افزار بانک اطلاعاتی، امکانات بیشتری از ایجاد یک لیست ساده که در نرم افزارهای واژه پرداز یا صفحه گسههترده

وارد کرده ایم، از قبیل ایجاد گزارش، فرم در اختیار ما قرار می دهد.

تفاوت بین داده و اطلاعات- 1.1.2 

 برخی از لغات و الفاظ انگلیسی هستند زمانیکه ترجمه می  شوند و یا حتی به زبان اصههلی خوانههده می  شههوند بههه جههای

 نیههز از ایههن جملههه2 و اطلاعههات1همدیگر به سادگی استفاده می شوند در حالیکه ماهیت هر کدام از آنها جداگانه اسههت، داده

واژه ها می باشند.

1 Data
2 Information
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در یک توضیح خلصه، داده در واقع واقعیت ها و آمار و ارقامی هستند که بصورت خام جمع آوری می شوند که به اعنوان

مرجع مورد استفاده قرار بگیرند، اطلاعات نتیجه پردازش و تجزیه و تحلیل داده ها می باشد که به دید کاربر می رسد. 

 و صفحه گسترده پایگاه دادهنتفاوت های میا- 1.1.3 

 از نظر ورود داده ها شبیه به هم هستند، اما اختلفاتی بین این دو نرم افههزار1هر دو نرم افزر پایگاه داده  و صفحه گسترده

وجود دارد، که مهمترین آنها اعبارتند از:

فایل های تخت در مقابل پایگاه داده های رابطه ای: ابتدایی ترین سطح پایگاه داده ها، فایل هههای تخههت هسههتند کههه•

داده ها تنها در یک جدول ذخیره می شوند ولی در پایگاه داده ها اطلاعات به صهورت مرتبهط در جهداول مختلهف

قرار می گیرد.

 نرم افزار صفحه گسترده یک نرم افزار محاسباتی با سههلول های هوشههمند اسههت، کههه از آن می تههوان بههرای انجههام•

محاسبات مالی و حسابداری استفاده نمود.

 اما در سطح ابتدایی که برای ذخیرهOrocle و SQL Server یک نرم افزار بانک اطلاعاتی همانند Base نرم افزار •

داده ها مورد استفاده قرار می گیرد. تفاوتی که پایگاه داده  را از صفحه گسترده جدا می سههازد، ارتبهاط جهداول بها

یکدیگر که در صفحه گسترده این امکان وجود ندارد.

ه داده ههها در ارتبهاط قهرار• اگر بخواهیم در صفحه گسترده یک جدول را به جدولی دیگر ارتباط بدهیم، بطوری ک

بگیرند، با مشکل مواجه می شویم، پس از نرم افزار پایگاه داده  بدلیل داشتن امکان ارتباط بیههن جههداول اسههتفاده

1 Spreadsheet
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می کنیم.

جدول و اجزای آن- 1.2 
سازماندهی پایگاه داده از نظر جداول، رکوردها، فیلدها- 1.2.1 

 اسههت.1اطلاعات موجود در بانک اطلاعاتی توسط مجمواعه ای از اشیا سازماندهی می شود که مهمترین شی آن، جدول

 است.جدول هر بانک اطلاعاتی حداقل شامل یک

 مشاهده می کنیم.1:1جدول برای درک مفهوم جدول، یک جدول از بانک اطلاعاتی شرکت سافا را در 

دپارتماننام خانوادگینامکد ملی شناسه کارمند

۹حاجی زادهمجید۶۴۴2۰۳۵۶

۹اعارف منشحسین۵۴۴۳

12فلاحابراهیم۸۴۴۳۰۳۳2

11حیدریاحسان۷۵۵2

1۰اعلویاعلی۴۷۸۸۷

: مشخصات کارمندان1:1جدول 

 محسوب می شود.یک رکورد از مجمواعه ای از اقلم اطلاعاتی مرتبط با هم تشکیل شده است2هر سطر جدول یک رکورد

1 Table
2 Record

فیلد

رکورد
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 نشان داده ایم.1:1جدول  گفته می شود.همانطور که در 1که به هرکدام از این اقلم فیلد

در واقع هر ستون جدول یک فیلد محسوب می شود.

 اصلیآشنایی با کلید- 1.2.2 

برای اینکه بتوانید یک رکورد را در یک جدول پیدا کنید، هر رکورد در هر جدول نیاز به یک شناسایی کننده منحصر بههه

مارهBase دارد. شما می توانید کلید اصلی را خودتان معین کنیههد یهها اینکههه 2کلید اصلیفرد به نام  ک ش تفاده از ی ا اس  ب

افزایشی خودکار آن را برای شما ایجاد خواهد کههرد. تعریههف کلیههد اصههلی از وجههود داده هههای تکههراری در جههدول جلههوگیری

می کند.توضیحات کاربردی کلید اصلی در بخش های آینده داده خواهد شد.

شاخصآشنایی با - 1.2.3 

اخص راBase یک مکانیزم برای سراعت بخشیدن به جست وجو است. ۳شاخص ادیر ش ده از مق ب ش  یک فهرست مرت

نگهداری می کند.  تا بتواند مقدار مورد نظر را با جست وجو در یک فهرست مرتب شده، سریعتر از جست وجو در یک فهرسههت

مرتب نشده پیدا کند.توضیحات کاربردی کلید اصلی در بخش های آینده داده خواهد شد.

 انواع داده - 1.2.4 

هر فیلد در جداول پایگاه داده بر اساس نوع استفاده ای که دارند، باید یکی از انواع داده های متن، اعدد، تاریخ و یا غیههره

باشند. استفاده از انواع داده بااعث می شود کاربر در هنگام ورود اطلاعات دچار اشتباه کمتری شود. در ادامه انواع داده ههها در

1 Field
2 Primary key
3 Index
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base.شراح داده خواهد شد 

انواع داده رشته ای:•

 می باشد. در این نوع فیلد ها، برای نگهداری هر حرف، یک بایتASCIIاین نوع فیلد برای نگهداری اعبارات و یا حروف 

 نشان داده ایم. 1:2جدول اشغال می شود. همانطور که در 
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 شرحنوع داده

Text (fix) [ CHAR ] حرف با طول ثابت ذخیره۴۰۰۰ تا حداکثر ۱در این نوع داده، اطلاعات از 
می شود.

Text [ VARCHAR ]

 درVarChar و Char مگا حرف ذخیره می شود.  فرق بین ۱ تا ۱اطلاعات از 
، طول رشته ثابت است. یعنی اگر یک فیلد را از نوعCharاین است که در 

Char(20) معرفی کرده و در آن کلمه Orion حرف2۰ را قرار دهیم، اعین 
۱۵ کاراکتر اول را کلمه مربوطه اشغال کرده و ۵استفاده خواهد شد. یعنی 

 اینگونه نیست.VarChar خواهند بود. اما در Blankکاراکتر باقی مانده، 

Text
[VARCHAR_IGNORECASE]

 است که تفاوت بین حروف بزرگ و کوچک را نادیده می گیرد.varcharهمان 

Memo [ LONGVARCHAR ]

 کارکتر حرفي را می پذیرد.این نوع داده مانند نوع داده6۵۰۰۰نوع داده متني که 
Textمیباشد با این تفاوت که برای فیلدهایی استفاده میشود که چند خطی 

 کارکتر است.مثل فیلد یادداشت و2۵۵هستند و تعداد کارکترهای انها بیش از 
غیره

: انواع داده رشته ای1:2جدول 

انواع داده دودویی:•

جدول این نوع فیلد ها برای نگهداری اطلاعات بصورت دودویی مانند تصاویر و فایل ها مناسب هستند. همانطور که در 

 نشان داده ایم. 1:۳
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شرح نوع داده

Binary (fix) [ BINARY ] بایت را در خود جای می دهند.۸۰۰۰ تا 1این نوع فیلد ها، از 

Binary [ VARBINAR ]
 بایت را در خود جای می دهند. (متغیر).۸۰۰۰ تا 1این نوع فیلد ها هم از 

Image [ LONGVARBINARY ]

) را شامل2,1۴۷,۴۸۳,۶۴۷ یا (2^۳1-1 تا ۰داده های باینری با طول متغیر از 
می شود. برای ذخیره تصاویر مثل لوگوی یک شرکت از این نوع داده استفاده
می شود . داده یا تصویر ذخیره شده بعنوان رشته ای از بیت ها ذخیره شده و

 تفسیر نمی شود. و تفسیر هر گونه داده ی تصویری ذخیره شده بهBaseتوسط 
کمک نرم افزارها می باشد. مثل یک نرم افزار می تواند یک داده ی موجود در

Image ذخیره کند.نرم افزاری که داده ها را از JPEGستون تصویر را با قالب 

columnمی خواند باید به درستی قادر به تشخیص قالب داده ها و نمایش آنها 
 یک مکان برای ذخیره رشته بیت ها که در واقعImage columnباشد. یک 

مقداری را برای داده های تصویری می سازند ، فراهم می کنند. 

: انواع داده باینری1:3جدول 
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انواع داده اعددی:•
1:۴جدول این نوع فیلد برای نگه داری انواع ااعداد صحیح و ااعشاری مورد استفاده قرار می گیههرد.  همههانطور کههه در 

نشان داده ایم.

شرح نوع داده

Tiny integer[ TINYINT ] را در بر می گیرد.2۵۵ تا ۰ تنها یک بایت را ذخیره می کند و محدوده ااعداد صحیح 

Small Integer [ SMALLINT ] مثبت را در خود ذخیره کند.۳2۷۶۷ منفی تا ۳2۷۶۷یک اعدد دو بایتی است و می تواند از 

Integer [ INTEGER ] میلیارد را در خود ذخیره کند.2یک اعدد چهار بایتی است که می تواند ااعداد بین مثبت و منفی 

BigInt [ BIGINT ] میلیارد را در خود ذخیره کند.۴ بایتی است که می تواند ااعداد بین مثبت و منفی ۸یک اعدد 

Decimal [ DECIMAL ].این نوع فیلد برای نگهداری ااعداد ااعشاری با تعداد ااعشار مشخص استفاده می گردد

Number [ NUMERIC ]

این نوع داده ها برای ذخیره داده هایی با ااعداد ااعشاری دارای ممیز شناور بدون گرد کردن
استفاده می شوند و باید در آنها کل ارقام قابل ذخیره (دقت) و ارقام ااعشاری قرار گرفته در سمت

 را در بر1۰^۳۸-1- تا 1۰^۳۸-1راست ممیز ااعشار مشخص می شود. این نوع داده ها محدود
می گیرند.

Real [ REAL ] نگهداری می شوند.1۰ بایتی است که ااعداد بصورت توانی از ۴یک اعدد 

 Float [ FLOAT ] نگهداری می شوند.1۰ بایتی که ااعداد بصورت توانی از ۸یک اعدد 

Double [ DOUBLE ] معنایdouble یعنی دوبرابر به این معنی که دو برابر float بایت.1۶ می باشد یعنی 

: انواع داده عددی1:4جدول 
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انواع داده تاریخ و زمان:•
این نوع فیلد ها برای نگهداری تاریخ میلدی و سااعت استفاده می شود و برای تاریخ شمسی کاربرد ندارد. همانطور کههه

 نشان داده ایم. 1:۵جدول در 

شرح نوع داده

Date [ DATE ]

-YYYYبرای ذخیره ی تاریخ کاربرد دارد . فرمت رشته ای آن به صورت 

MM-DD می باشد که YYYY را برای۹۹۹۹ تا ۰۰۰1 محدوده ارقام 
 را۳1 تا ۰1 ارقام DD را برای نمایش ماه و 12 تا ۰1 ارقام MMنمایش سال و 

با توجه به ماه مورد نظر ،برای نمایش روز می توانند در بر گیرند.

Time [ TIME ]

ستون های از این نوع زمان را در خود ذخیره می کنند . فرمت رشته ای آن [
hh:mm:ss[.nnnnnnn تا۰۰:۰۰:۰۰.۰۰۰۰۰۰۰می باشد و محدوده 

 می تواند شامل شود.2۳:۵۹:۵۹.۹۹۹۹۹۹۹

Date/Time [ TIMESTAMP ]
وقتی بخواهیم فیلدی بسازیم که قابلیت نمایش تاریخ و زمان را داشته باشد

 استفاده می کنیمDate/Timeازنوع داده 

: انواع داده تاریخ و زمان1:5جدول 

طراحی پایگاه داده و قوانین آن- 1.3 
تعریف مساله و شناخت اجزای آن- 1.3.1 

 قبل از شروع فرآینههد سههاختن یههک پایگههاه داده ، بایههد ازپیش از آنکه پایگاه داده  بسازیم، لزم است آن را طراحی کنیم.
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خودمان تعدادی سؤال بپرسیم اول، ببینیم که می خواهیم چه اطلاعاتی را از پایگاه داده  به کههاربر بههدهیم. داشههتن یههک ایههده

روشن از اطلاعاتی که پایگاه داده  قرار است بدهد، قبل از رفتن به مرحله بعد بسیار اهمیت دارد.

وقتی فهمیدیم که چه اطلاعاتی از پایگاه داده  می خواهیم آنگاه می توانیم تصمیم بگیریم کههه چههه اطلاعههاتی پایگههاه داده 

شما نیاز دارد تا این اطلاعات برای شما تولید کند و به دنبال آن شما می توانید برروی ساختار پایگاه داده  خود در قالب فیلههدها

و یا جدول ها، تصمیم گیری کنید.برای روشن ساختن ساختار پایگاه داده  رسم نمودار که نشههان دهنده نحههوه اتصههال تکه هههای

مختلف اطلاعات بایکدیگر مفید خواهد بود.

مسأله را می توان وضعیتی تعریف کرد که در آن فاصله ای بین آنچه هست و آنچه بایههد باشههد، وجههود دارد. همچنیههن

مسأله، وضعیتی است که گزینه های دیگری غیر از گزینه موجود مطراح باشد.  با این حساب مسأله (یهها خواسههته) مهها اعبههارت

است از تحقق وضعیت مطلوب (وضعیتی که می خواهیم باشد). وضعیت مطلوب در واقع هدفی است که ما می خواهیم محقههق

شود پس به بیان ساده تر مسأله، تحقق هدف است.

ارتباط بین ساختار جدول و داده های یک شی- 1.3.2 

همانطور که در دنیای واقعی اشیائی در اطراف ما هستند و دارای خصوصیت های خاصی هستند، در پایگاه داده ههها ایههن

اشیاء  توسط یک یا چند جدول تعریف می شوند و خصوصیت های آن ها نیز توسط فیلد های آن جدول معرفی خواهد شد.شایان

ذکر است منظور از اشیاء  هرموجود زنده یا شیء غیر زنده می باشد که در تعریف مساله ابتدا باید این اشیاء شناسایی شوند.  به

اعنوان مثال در هنگام طراحی پایگاه داده برای یک شرکت، این پایگاه داده شامل اشیائی چون دپارتمان، کارمند، وسائل و غیره

می باشد که برای معرفی هرکدام از این اشیاء  می توانیم یک یا چند جدول داشته باشیم. کارمندان دارای خصوصیاتی چون نام،
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نام خانوادگی، سن و غیره می باشند که برای هرکدام از این خصوصیات (بر اساس نیاز مساله) می توانیم در جدول مربوطه فیلد

داشته باشیم.

 میان جداولارتباطاهمیت - 1.3.3 

دلیل استفاده از ارتباطات بین جداول ایهن اسهت کهه از ورود داده ههای تکهراری بی مهورد و شهلوغی بانهک اطلاعههاتی

هلذا هر بخش از اطلاعههات مرتبهط را در یهک جهدول سهازماندهی می کنیهم.جلوگیری شود  طهور مثهال بانهک اطلاعههاتی.  ب

db_saafaaجدول، یکی مشخصات کارمندان و دیگری مشخصات دپارتمان لزم است برای اینکههه دو  را در نظر بگیرید حداقل

 برقرار کرد.1مشخص شود هر کارمند در کدام دپارتمان است باید بین این دو جدول ارتباط

در برقراری ارتباط باید فیلدی انتخاب شود که نماینده برقراری این ارتباط شود پس باید این فیلد شاخص باشد، یعنههی

.همچنین این فیلد باید کلید اصلی شود.شاخص گذاری شود

 نشان داده ایم.1.۳.1شکل در اینجا فیلد شناسه دپارتمان به اعنوان کلیداصلی در نظر گرفته می شود.همانطور که در

1 Relationships
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در فصل بعد با انواع رابطه بین جداول آشنا خواهیم شد.

خارجیآشنایی با کلید - 1.3.4 

 برای ارتباط یک جدول با جداول دیگر است (البته برای ارتباط بین موجودیت ها در زمان طراحی)1کلید خارجی

کلید اصلی در یک جدول، کلید خارجی در جدولی دیگر است که با آن ارتباط دارد. در فصههل بعههدی بهها یههک مثههال بهها

 نشان داده ایم شناسه دپارتمان در جدول «دپارتمان» بههرای جههدول1.۳.1شکل کاربرد آن آشنا خواهیم شد.همانطور که در 

«کارمندان» کلید خارجی محسوب می شود.

1 Foreign key

: ارتباط بین دوجدول1.3.1شکل 
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حفظ یکپارچگی روابط بین جدول ها- 1.3.5 
حفظ یکپارچگی، ااعتبار و نظم داده ها از اهمیت بسیار بالیی برخوردار است و در صورتیکه طرااح پایگههاه داده در زمههان

ساخت اولیه بانک اطلاعاتی خود با توجه به تحلیل به دست آمده از پروژه خود، تمهیدات مناسههبی را بههرای ایههن امههر در نظههر

نگیرد، بانک اطلاعاتی او بعدها به مشکلت بزرگی بر خواهد خورد.یکی از راه های حفههظ یکپههارچگی داده در ایههن پایگههاه داده

 می باشد.این کار از صحت کیفیت داده ها اطمینان حاصل می نماید و همچنین به شماData Integrityاستفاده از تکنیک های 

کمک می کند تا داده های خود را بدون تغییر و منحصربه فرد حفظ نمایید.

 از جمله کارهایی که برای راعایت حفظ یکپارچگی باید راعایت شود می توان به استفاده از انواع داده مناسههب بههرای هههر

هههاtrigerفیلد، استفاده از قوانین ااعتبارسنجی مناسب برای هرفیلد، تعیین مقدار پیش فرض برای فیلد و همچنین استفاده از 

برای کلید های خارجی در هنگام به روزرسانی، حذف، و ورود اطلاعات استفاده نمود.

آشنایی با نرم افزار پایگاه داده  ها- 1.4 
LibreOfficeآشنایی و نصب مجمواعه نرم افزاری - 1.4.1 

 LibreOffice یک نرم افزار آزاد و تحت مجوز GNU LGPLتوسعه1 مجمواعه اداری است که توسط بنیاد داکیومنت 

 برگرفته شده است. هدف توسعه دهندگان این است کههه یههک مجمههواعه2داده می شود. این نرم افزار از مجمواعه اداری اپن آفیس

Libre از دو کلمه LibreOffice تولید کنند که مشکل حق تکثیر نداشته باشد. کلمه ODFاداری مستقل با قابلیت پشتیبانی 

 (انگلیسی) به معنی مجمواعه اداری، تشکیل شده است.Office(فرانسوی یا اسپانیایی) به معنایی آزادی و کلمه 

1 Documents
2 OpenOffice
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 LibreOffice++به زبان های Cجاوا و پایتون نوشته شده است و بر روی اکثر سامانه اعامل ها مثل ویندوز، مک اواس و ،

گنو/لینوکس کار می کند. از قابلیت های این نرم افزار سازگاری با اکثر مجمواعه های اداری موجود همچون مایکروسافت آفیههس

است.

دامlibreoffice.org به سایت LibreOfficeبرای دریافت مجمواعه نرم افزاری   مراجعه کرده و نسبت به سامانه اعامل اق

 نیز نصب خواهد شد.Baseبه دریافت نسخه نگارشی نمایید. پس از نصب مجمواعه نرم افزاری، نرم افزار پایگاه داده  

 استفاده می کنیم.LibreOffice مجمواعه اداری ۵٫2٫2ما در این جزوه از نگارش 

باز و بستن پایگاه داده و چگونگی اتصال به پایگاه داده های مختلف- 1.4.2 

بازکردن پایگاه داده 

برای بازکردن یک پایگاه داده سه روش وجود دارد:

 کلیک می نماییم.Open را باز می کنیم در پنجزه باز شده گزینه دوم را انتخاب و برروی LibreOffice Baseنرم افزار •

 نشان داده ایم.1.۴.1شکل همانطور که در 

http://libreoffice.org/
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 نشان داده ایم.1.۴.2شکل  فایل مورد نظر را انتخاب می کنیم.همانطور که در Openدر پنجره 

1

2

: بازکردن پایگاه داده1.4.1شکل 

1

2
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 نشان داده ایم.1.۳.1شکل  را انتخاب می کنیم. همانطور که در File>Openدر محیط نرم افزار مسیر •

: انتخاب فایل مورد نظر1.4.2شکل 

2

1
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  فایل مورد نظر را انتخاب می کنیم.Openدر پنجره 

 کلیک و فایل مورد نظر را انتخاب می کنیههم. همههانطوردر محیط نرم افزار در نوار ابزار استاندارد برروی آیکون •

 نشان داده ایم.1.۴.۴شکل که در 

File:نمای 1.4.3شکل 
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بستن پایگاه داده 
 در نمای پایگاه داده را انتخاب می کنیم.File>Closeبرای بستن پایگاه داده نیز مسیر 

اتصال به پایگاه داده های مختلف

: باز کردن پایگاه داده1.4.4شکل 

1
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 می شویم در پنجره بازشده گزینه سوم را انتخاب می کنیمBaseبرای اتصال به پایگاه داده های دیگر ابتدا وارد نرم افزار .1

انطورSpreadsheetو از گزینه های موجود در باکس کشویی اعبارت   را انتخاب می کنیم و به مرحله بعد می رویم. هم

 نشان داده ایم.1.۴.۵شکل که در 

ه در Browsدر مرحله بعد با کلیک برروی گزینه .2 انطور ک م. هم 1.۴.۷شکل ، پایگاه داده مورد نظر را اضافه می کنی

1

: اتصال به پایگاه داده1.4.5شکل 

1
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نشان داده ایم. 

: انتخاب پایگاه داده مورد نظر1.4.6شکل 

1
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ه درFinishدر گام آخر روی .۳  نشههان1.۴.۸شکل  کلیک می کنیم و محل ذخیره فایل را تعیین می کنیم. همانطور ک

داده ایم. 

: انتخاب فایل مورد نظر1.4.7شکل 

1
2
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 ایجاد پایگاه داده جدید و ذخیره آن- 1.4.3 
 می شویم و اعملیات  زیر را انجام می دهیم :Baseبرای ایجاد پایگاه داده  جدید ابتدا وارد نرم افزار 

Databaseدر پنجره .1  Wizard ه در انطور ک 1.۴.۹شکل  گزینه اول را انتخاب می کنیم و به گام بعدی می رویم. هم

نشان داده ایم. 

Database Wizard: پنجره 1.4.8شکل 
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هFinishدر گام دوم بدون تغییر برروی دکمه .2 انطور ک  کلیک می کنیم، نام و مکان مورد نظر را تعیین می نماییم. هم

: ایجاد پایگاه داده جدید1.4.9شکل 

1

2
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 نشان داده ایم.1.۴.1۰شکل در 

: ایجاد پایگاه داده1.4.10شکل 

برای استفاده در ایجاد جدول از طریق 
ویزارد کاربرد دارد

جدول را در حالت ویرایش 
ایجاد می کند
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آشنایی با بخش های مختلف نرم افزار پایگاه داده ها- 1.4.4 
 نشان داده ایم.1.۴.11شکل محیط نرم افزار شامل موارد زیر است: همانطور که در 

نوار اعنوان:

تهBaseنوار رنگی در بالترین قسمت برنامه  وار نوش  قرار دارد و نام فایلی که در حال حاضر در آن قرار داریم در این ن

شده است.در قسمت سمت راست این نوار دکمه های بستن، پیشینه کردن، کمینه کردن وجود دارد.

نوار منو:

نواری است که در زیر نوار اعنوان قرار دارد و شامل منوهای اصلی برنامه هست.

نوار ابزار استاندارد:

نواری است که در زیر نوار منو برنامه قرار دارد و شامل آیکون هایی جهت دسترسی سریع به فرامین مهم برنامه هست.

نوار وضعیت:

نوار مستطیلی در پایین ترین قسمت صفحه هست.

نمای توضیحات:

 آیکون راآن می رود توضیحات مربوط به Tasksدر سمت راست وجود دارد و زمانیکه اشاره گر برروی آیکون های محیط 

نشان می دهد.
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:نماهای پایگاه داده
،Tables، Queries، Forms را نماهای پایگاه داده تشکیل می دهد این نماها اعبارتند از: Baseقسمت سمت چپ محیط 

Report 

 سفارشی کردن ابزارها در نوار ابزار- 1.4.5 
ابزارهای مختلف به صورت نمادهای گرافیکههی کوچههک در نههوارابزار نمههایش داده می شههوند. برحسههب نیههاز می تههوانیم

Base: محیط نرم افزار 1.4.11شکل 

نوار اعنوان

 نوار منو

نوار ابزار استاندارد

نوار وضعیت

نمای توضیحات

 نما های پایگاه داده
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ابزارهایی را نمایش دهیم یا مخفی کنیم. برای این کار اعملیات زیر را انجام می دهیم.

 باز شود.customize را انتخاب می کنیم تا پنجره Tools>Customizeگزینه .1

 کلیک می کنیم.Toolbarsروی سربرگ.2

 نوار ابزار موردنظر را انتخاب می کنیم.Toolbarاز قسمت .۳

 ابزارها نمایش داده می شوند.Toolbar contentدر قسمت .۴

اعلمت دار کردن هر ابزار بااعث نمایش و برداشتن اعلمت بااعث مخفی شدن ابزار می شود..۵

 نمایش داده ایم.1.۴.12شکل همانطور که در 
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1

با برداشتن هرکدام از تیک ها 
ابزار مورد نظر مخفی می شود

:سفارشی کردن ابزارها1.4.12شکل 

برای اضافه کردن ابزار جدید به 
نوار ابزار استاندارد

با برداشتن هرکدام از تیک ها 
ابزار مورد نظر مخفی می شود

1
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 LibreOfficeآشنایی با سایت و راهنمای مجمواعه نرم افزاری - 1.4.6 

 :LibreOffice نرم افزاری ایت مجمواعهس
 به آدرس زیر مراجعه می کنیم:LibreOfficeبرای ورود به سایت مجمواعه اداری 

www.LibreOffice.org

شکل بعد از ورود پنجره ای باز می شود که پیشنهاد دانلود آخرین نسخه ایههن مجمههواعه را می دهههد. همههانطور کههه در 

 نشان داده ایم.1.۴.1۳

LibreOffice: نمای سایت مجموعه اداری 1.4.13شکل 

http://www.LibreOffice.org/
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شکل  وارد سایت می شویم و می توانیم از آن استفاده کنیم. همانطور که درTo the Homepageبعد از کلیک بر روی 

 نشان داده ایم.1.۴.1۴

 برنامه:helpاستفاده از 
لل به کمک احتیاج داشتیم Baseاگر هنگام کار با  نHelp آنچه را که نیاز داریم در بخش احتما رای ای  خواهیم یافت.ب

 ازمی توانیم می رویم.همچنین Help به بخش Help>Libreoffice یا از منوی صفحه کلید استفاده می کنیم. از F1کار از کلید 

: نمای سایت1.4.14شکل 
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 زا مشاهده کنیم.Baseلینک زیر استفاده کرده و راهنمای 

https://help.libreoffice.org/Base/Welcome to the   Base Help

 را مشاهده می کنیم.Helpدر شکل زیر نمایی از صفحه 

Help: نمای 1.4.15شکل 

https://help.libreoffice.org/Calc/Welcome_to_the_Calc_Help
https://help.libreoffice.org/Base/Welcome_to_the
https://help.libreoffice.org/Base/Welcome
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جداول-  2 
کار با جداول- 2.1 
باز کردن یک جدول- 2.1.1 

ربرگ database را باز می کنیم.در نمای db_SaaFaaابتدا پایگاه داده  • ایین،Tables وارد س مت پ ویم و در قس  می ش

جدول« کارمندان» را با دوبار کلیک روی آن باز می کنیم.

ه در Openروش بعد با کلیک راست روی جدول مورد نظر و انتخاب گزینه • 2.1.1شکل  انجام می گیرد. همانطور ک

نشان داده ایم.
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: با ز کردن جدول2.1.1شکل 
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آشنایی با مفاهیم سطر، ستون، فیلد و رکورد- 2.1.2 
مفهوم سطر و ستون همان فیلد و رکورد در پایگاه داده هسههت کههه تعریههف رکههورد و فیلههد در زیههر آمده اسههت.اغلههب در

 استفاده می شود.2 و ستون1صفحه گسترده از اعبارت سطر

رکورد

 هر سطر در پایگاه داده، رکورد نامیده می شود. رکوردها بصورت سطر در یک جدول پایگاه داده ظاهر می شوند، یعنی هر

سطر، یک رکورد است.

فیلد

 اطلاعات تفصیلی که یک رکورد را تشکیل می دهند به دسته هایی به نام فیلد شکسته می شوند. وقههتی کههه یههک پایگههاه

داده را طراحی می کنید، فکر کنید که برای هر رکورد به چه فیلدهایی نیاز دارید. برای مثال، یک پایگاه داده بههرای آدرس بههه

فیلدهایی برای نام، نام خانوادگی، آدرس، شهر، استان، کدپستی و شماره تلفن نیاز دارد.

حرکت بین رکوردهای یک جدول- 2.1.3 

دهایEnterبرای اینکار با زدن دکمه  وانیم از کلی ن می ت  می توانیم بین رکوردهای یک جدول حرکت کنیم.  و همچنی

جهت دار برای اینکار استفاده نماییم.

مرتب کردن رکوردها- 2.1.4 

 واردبرای مرتب کردن رکوردهای یک جدول به طور مثال جدول «کارمندان» را باز می کنیم.  با استفاده از آیکههون 

1 Row
2 Column
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 نشان داده ایم.2.1.2شکل  می شویم.همانطور که در Sort Orderپنجره 

 فیلد مورد نظر را که برای مرتب سازی نیاز است را انتخاب می کنیم.  وField name در قسمت Sort Orderدر پنجره 

 نشان داده ایم.2.1.۳شکل  نوع مرتب سازی را مشخص می کنیم.همانطور که در Orderدر قسمت 

: انتخاب آیکون مرتب سازی2.1.2شکل 
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فیلتر کردن رکوردها- 2.1.5 
 وارد پنجرهبرای فیلتر کردن داده های یک رکورد ابتدا وارد جدول «کارمندان» می شویم و با کلیک برروی آیکون 

Standard Filter نشان داده ایم. 2.1.۴شکل  می شویم. همانطور که در 

: مرتب سازی سفارشی2.1.3شکل 

مرتب سازی براساس حروف 
کوچک به بزرک

مرتب سازی براساس حروف 
بزرگ به کوچک
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برای فیلتر کردن نام و نام خانوادگی اعملیات زیر را انتخاب می کنیم:

 فیلد نام را انتخاب می کنیم.Field nameدر قسمت .1

 شرط را انتخاب می کنیم.Conditionدر قسمت .2

 اعبارتنداز:Conditionشرط های موجود در قسمت 

 را برمی گرداند.Value= (مساوی): همان اعبارت تعیین شده در قسمت •

<> (نامساوی) : به غیراز اعبارت تعیین شده بقیه رکوردها را برمی گرداند.•

: انتخاب آیکون فیلتر 2.1.4شکل 
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> (کوچکتر از) : مقدارهایی که کمتر از فیلد انتخاب شده هست را نمایش می دهد.•

 از فیلد انتخاب شده است را نمایش می دهد.بزرگ تر از) : مقدارهایی که بزرگ تر< (•

 یا مساوی را نمایش می دهد.بزرگ تر مساوی از) : مقدارهایی بزرگ تر=< (•

=> (کوچکتر مساوی از): مقدارهایی کوچکتر یا مساوی را نمایش می دهد.•

•Like مقادری که با حرف مشخص شده در فیلد : Value.شروع شده باشد را نمایش می دهد 

•not like.مقادیری که با حرف مشخص شده شروع نشده باشد را نمایش می دهد : 

•Null.فیلدهایی که خالی هستند را نشان می دهد : 

•not null.فیلدهایی که خالی نیستند را نمایش می دهد : 

 مقدار یا اعبارت شرط را وارد می کنیم.Valueدر فیلد .۳

 به همین گونه برای نام خانوادگی فیلتر را ااعمال می کنیم..۴

 نشان داده ایم. 2.1.۵شکل همانطور که در 
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تغییر نحوه نمایش- 2.1.6 

) واردEdit Data ( برای تغییر نحوه ی نمایش، ابتدا وارد جدول موردنظر می شویم سپس با کلیک برروی آیکون 

نمای نمایش داده ها می شویم با این تفاوت که دیگر قابلیت ویرایش را نداریم.برای بازگشت بههه حههالت ورود داده دوبههاره روی

 نشان داده ایم. 2.1.۶شکل  کلیک می نماییم. همانطور که درEdit dataآیکون 

: فیلتر کردن داده های یک جدول2.1.5شکل 

انتخاب رکورد برای فیلتر

شرط لزم برای ااعمال فیلتر

ااعمال شرط برای 
فیلترهای بعدی
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جابه جایی ستون در یک جدول- 2.1.7 
برای جابه جایی ستون در یک جدول اعملیات زیر را انجام می دهیم:

 را انتخاب می کنیم.Edit برروی جدول مورد نظر کلیک راست کرده و گزینه Tablesدر نمای .1

فیلد کد ملی را انتخاب می کنیم..2

 را انتخاب می کنیم.Cutکلیک راست کرده و گزینه .۳

 را انتخاب می کنیم.Pastدر فیلد نام خانوادگی کلیک راست کرده و گزینه .۴

Edit Data: انتخاب آیکون 2.1.6شکل 
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فیلد کدملی در بالی نام خانوادگی قرار می گیرد..۵

 نشان داده ایم.2.1.۴شکل همانطور که در 

در جابه جایی ستون های یک جدول هنگام چسباندن، فیلد موردنظردر بالی فیلدی که در آنجا چسباندیم قرار می گیرد. نکته:

ورود داده به جدول- 2.1.8 
برای ورود داده به جدول ابتدا جدول «کارمندان» را بههاز می کنیههم سههپس جههدولی شههبیه صفحه گسههترده را مشههاهده

کلیک برروی این قسمت برای 
انتخاب جابه جایی ستون

کلیک برروی این قسمت برای 
انتخاب جابه جایی ستون

کلیک برروی این قسمت برای 
انتخاب جابه جایی ستون

کلیک برروی این قسمت برای 
انتخاب جابه جایی ستون

: جابه جایی ستون در جدول2.1.7شکل  : جابه جایی ستون در جدول2.1.3شکل  : جابه جایی ستون در جدول2.1.3شکل  : جابه جایی ستون در جدول2.1.3شکل  : جابه جایی ستون در جدول2.1.4شکل 

کلیک برروی این قسمت برای 
انتخاب جابه جایی ستون
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 نشان داده ایم.2.1.۸شکل می کنیم که می توانیم با کلیک برروی هر خانه از جدول داده را وارد کنیم. همانطور که در 

حذف رکورد در جدول- 2.1.9 
برای حذف رکوردهای یک جدول اعملیات زیر را انجام می دهیم:

روش اول

2.1.۹شکل ایتدا رکورد موردنظر را با کلیک برروی خانه ی خالی کنار صفحه انتخاب می کنیم. همانطور کههه در .1

نشان داده ایم. 

: ورود داده به جدول2.1.8شکل 

قسمت ورود اطلاعات جدید
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 نشان داده ایم.2.1.1۰شکل  را انتخاب می کنیم..همانطور که در Edit>Delete Recordمسیر .2

: حذف رکوردهای یک جدول2.1.10شکل 

: انتخاب رکورد2.1.9شکل 

 محل انتخاب رکورد
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روش دوم:

رکورد موردنظر را انتخاب می کنیم..1

 از صفحه کلید را فشار می دهیم.Deleteدکمه .2

 اضافه، اصلح یا حذف داده های یک رکورد- 2.1.10 

برای اینکار برروی خانه های جدول کلیک می کنیم سپس می توانیم داده را از رکورد حذف یا اصلاح نماییم.

ارDeleteهمچنین برای حذف داده های یک رکورد برروی خانه ی مورد نطر کلیک کرده و دکمه  فحه کلید را فش  از ص

می دهیم.

: نمای طراحی برای حذف یا اضافه داده2.1.11شکل 

حالت انتخاب داده برای 
حذف یا اصلاح
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ایجاد و ذخیره جدول- 2.2 
ایجاد جدول از طریق ویزارد- 2.2.1 

، جداول و فیلدها از پیش تعییههن شههده می باشههد .بههرای نمههونه مهها یههک جههدول1در حالت ایجاد جدول از طریق ویزارد

employed:را ایجاد می کنیم 

شکل  کلیک می نماییم. همانطور که در  برروی گزینه Tablesابتدا در نمای .1

 نشان داده ایم.2.2.1

1 Wizard
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ه در Businessدر پنجره ی باز شده از گروه .2 انطور ک م. هم اب می کنی  نشههان2.2.2شکل  جدول مورد نظر را انتخ

داده ایم. 

: ایجاد جدول از طریق ویزارد2.2.1شکل 

1 2
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 نشان داده ایم. 2.2.۳شکل  منتقل می کنیم. همانطور که در Selected fieldsفیلدهای مورد نظر را به کادر .۳
: انتخاب جدول2.2.2شکل 

1

2
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در گام دوم می توانیم نام و نوع داده ها را تغیر بدهیم.در حالت ایجاد جههدول از طریههق ویههزارد نههوع داده ههها بههه طههور.۴

2.2.۴شکل  مطالعه نمودیم. همههانطور کههه در 1.2.۳ را از بخش Baseپیش فرض تعیین شده است.انواع داده ها در 

نشان داده ایم. 

: انتخاب فیلدهای جدول2.2.3شکل 

منتقل کردن فیلد به کادر سمت راست

 جابه جایی فیلدها
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در گام سوم می بایست کلید اصلی را برای جدول انتخاب نماییم.گزینه های موجود در گام سوم به شراح زیر می باشههد:.۵

 نشان داده ایم.2.2.۵شکل همانطور که در 

: ویرایش فیلدهای جدول2.2.4شکل 

حذف یا اضافه کردن یک فیلد  جابه جایی اولویت فیلدها

تغییر نام فیلد

تغییر نوع فیلد

اجباری نمودن 
برای ورود داده

تعیین اندازه حروف
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 نرم افزار به طور خودکار یک فیلد را به اعنوان کلید اصلی انتخاب می کند.)1(

خصFieldname برای انتخاب کلید اصلی می بایست خودمان از کادر )2( ود را مش لی بش  فیلدی که قراراست کلید اص

: انتخاب کلید اصلی2.2.5شکل 

1

3

2
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نماییم.

 برای انتخاب چند فیلد به اعنوان کلید اصلی است.)۳(

Auto value.با فعال کردن این گزینه فیلد کلید به طور خوکار مقدار می گیرد:

رروی employeeIDدر اینجا ما گزینه دوم را انتخاب می کنیم و با انتخاب  هNext به اعنوان کلید اصلی و با کلیک ب  ب

مرحله بعد می رویم.

در گام نهایی تنظیمات مربوط به نام جدول و چگونگی نمایش جدول بعد از ایجاد آن را تعییههن می نمههاییم. همههانطور.۶

 نشان داده ایم.2.2.۶شکل که در 
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جدول را به گونه ای ایجاد می کند که برای ورود داده به آن آماده باشد.)1(

 جدول برای طراحی های دوباره و ویرایش فیلدها و نوع آن داده ها ایجاد می شود.)2(

Form اعلوه بر نمایش جدول برای ورود داده پنجره ی )۳(  Wizardاز  را نیز برای ایجاد فرم از جدول مربوطه را ب

 توضیح داده خواهد شد۳می کند.طریقه ایجاد فرم از طریق ویزارد، در فصل 

تغییر نام جدول

1

: ویرایش نام جدول و نحوه نمایش2.2.6شکل 

2
3

1
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 نشان داده ایم.2.2.۷شکل  جدول را ایجاد می کنیم. همانطور که در Finish با انتخاب گزینه اول و کلیک برروی .۷

ایجاد جدول از طریق نمای طراحی- 2.2.2 
 اعملیات زیر را انجام می دهیم:1برای ایجاد جدول از طریق نمای طراحی

 کلیک می کنیم. روی گزینه Tasks، محیط Tablesدر نمای .1

 نشان داده ایم.2.2.۸شکل  در پنجره ی باز شده می بایست انواع فیلدها و نوع آن ها را مشخص کنیم.همانطور که در.2

1 Design View

: نمای جدول2.2.7شکل 
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 کلیک می کنبم و سپس نام جههدول را «ااعضههای هیئههت مههدیره»بعد از تعیین نام فیلد و نوع آن برروی آیکون .۳

 نشان داده ایم.2.2.۹شکل  کلیک می کنیم.همانطور که در Okمی گذاریم و روری 

: ایجاد جدول از نمای طراحی2.2.8شکل 

تعیین نام فیلد و نوع آن
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در مرحله بعد پنجره ی محاوره ای باز می شود و سؤالی می پرسد که آیا فیلههد کلیههد توسههط نرم افههزار سههاخته شههود یهها.۴

 نشان داده ایم.2.2.1۰شکل خودمان به صورت دستی تعیین نماییم. همانطور که در 

د وIDنرم افزار فیلدی تحت اعنوان Yes در صورت کلیک روی گزینه .۵ افه می کن دول اض  به اعنوان کلید اصلی را به ج

: تعیین نام  جدول2.2.9شکل 
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درغیراینصورت خودمان باید کلید اصلی را انتخاب کنیم.

ه No با کلیک بروی گزینه .۶ primary روی فیلد کناری«کد پرسنلی»کلیک راست کرده و برروی گزین  keyه  آن را ب

 نشان داده ایم.2.2.11شکل اعنوان کلید اصلی انتخاب می کنیم. همانطور که در 

:پنجره محاوره ای تأیید ساخت کلید اصلی2.2.10شکل 
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ویرایش جدول و مدیریت فیلدهای آن- 2.3 
اضافه کردن فیلد به جدول- 2.3.1 

برای اضافه کردن فیلد جدید به جدول موجود اعملیات زیر را انجام می دهیم:

 را انتخاب می کنیم.Edit روی جدول «کارمندان» کلیک راست نموده و گزینه Tables ابتدا در نمای .1

ه در .2  نشهان2.۳.1شکل در نمای طراحی، فیلدی به نام «شماره تماس» را با نوع اعدد اضافه می کنیهم. همهانطور ک

داده ایم.

: تعیین کلید اصلی2.2.11شکل 



جزوههیهآموزشیهمهارتهکارهباهنرمهافزارهپایگاههدادههها168هازه58صفحهه

حذف فیلدها در جدول- 2.3.2 
برای این منظور وارد نمای طراحی جدول «کارمندان» می شویم.در اینجا می خواهیم فیلههد «شههماره تمههاس» را حههذف

کنیم.

ابتدا روی «شماره تماس» دوبار کلیک می کنیم..1

: اضافه کردن فیلد جدید2.3.1شکل 
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 از صفحه کلید را فشار می دهیم.Deleteدکمه ی .2

آشنایی با ویژگی فیلدها- 2.3.3 
 وجود دارد، توضیح داده شده است.Field Propertiesدر جدول زیر لیست ویژگی هایی که در قسمت 

: حذف فیلد از جدول2.3.2شکل 
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توضیحاتویژگی

Entry required
(الزامی بودن)

 باشد یعنی کاربر باید این فیلد را واردYesاگر مقدار آن 
کند

Length
حداکثر کاراکترهای فیلد را تعیین می نماید(اندازه فیلد)

Default value
(مقدار پیش فرض)

مقدار تعیین شده را به صورت پیش فرض برای فیلد در نظر
می گیرد.در جاهایی کاربرد دارد که اگر کاربر داده ای را

وارد نکرد، فیلد مقدار پیش فرض داشته باشد.

Format example
نمونه فرمت دلخواه برای ورود داده(پوشش ورودی)

Decimal Places
(مکان نقطه ااعشار)

در فیلدهای اعددی، تعداد ارقام بعد از ااعشار را تعیین
می کند.

: مهم ترین ویژگی فیلدها2:1جدول 

تنظیم ویژگی فیلدها- 2.3.4 

Fieldبرای تنظیم خصوصیات یک جدول ابتدا وارد نمههای طراحههی می شههویم و در قسههمت   Propertiesات را  تنظیم

ااعمال کنیم.برای مثال نمای طراحی جدول «کارمندان» را باز کنید و فیلد «نام» را انتخاب کنید و در قسهمت پهایین پنجهره

 نشان2.۳.۳شکل تنظیمات مربوط به فیلد «نام» نمایش داده می شود. تنظیمات مورد نیاز را انجام می دهیم. همانطور که در 
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داده ایم. 

: تنظیمات ویژگی فیلدها2.3.3شکل 
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ایجاد قانون ااعتبارسنجی- 2.3.5 
 برای گذاشتن محدودیت روی فیلد مشخص به کار میههرود مثلا" میخهواهیم در یههک فیلههد فقههط1قوانین ااعتبارسنجی 

 بههه بعههد1۳۹۴ااعداد مثبت قرار گیرند و در صورت ورود ااعداد منفی، برنامه اخطار دهد. یا اینکه تاریخ ها در این فیلد از سههال 

 برنامه خطا دهد.1۳۹۴باشند و در صورت ورود تاریخ مربوط به قبل از سال 

هر فیلدی می تواند دارای قانون ااعتبارسنجی باشد.

ااعتبارسنجی هم بر روی فیلدهای جداول و هم بر روی کنترل های فرم ااعمال می شود.

اولین نوع ااعتبارسنجی تعیین نوع فیلد می باشد که در سطح جداول ااعمال می شود. زمانی که نوع فیلد را اعدد، متههن،

تاریخ می گذاریم به این معنی است که از ورود اطلاعات نادرست جلوگیری کردیم.

در سطح جداول هنگامی که نوع فیلد اعدد می باشد می توان طول آن را نیز مشخص کنند که این هم نواعی قانون ااعتبار

سنجی می باشد.

نتایج تغییر نوع داده ها یا ویژگی فیلد در یک جدول- 2.3.6 
پس ازاینکه یک جدول را ایجاد کردیم، ممکن است متوجه شویم که خصوصیات فیلد باید اصلاح شود.مثل اندازه فیلههد

کوچک است و یا نوع فیلد باید تغییر یابد.اگر داده هایی وارد جدول کرده باشیم، بعضی از تغییرات در سههاختار جههدول ممکههن

2۰ کاراکتر باشد و اندازه آن را به ۳۰ و Textاست به داده های موجود در جدول اسیب برساند.مثل اگر اندازه یک فیلد از نوع

 کاراکتر داشته باشههد، قسههمتی از داده هههای آن فیلههد2۰کاراکتر کاهش دهیم، در رکوردهایی که فیلد تغییر داده شده بیش از 

1 Validation
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حذف خواهدشد.

نحوه انتخاب کلید اصلی- 2.3.7 

 یا چنهد فیلهد باشههد بهه شهرط اینکهه مجمهوع ایهن فیلهدها مقهدار منحصهربه فردی2کلید اصلی می تواند مجمواعی از 

باشند.همچنین مقدار کلید اصلی نمی تواند خالی باشد.نرم افزار بانک اطلاعاتی به صورت پیش فرض اطلاعههات یههک جههدول را

براساس فیلد کلید اصلی مرتب می کند.همه فیلدهای کلیدی می توانند به اعنوان کلید اصلی انتخاب شوند ولی ما باید فیلههدی

را که مناسب تر است انتخاب نماییم.مثل در جدول اطلاعات «کارمندان» فیلد شماره پرسنلی و فیلد کههد ملههی منحصههربه فرد

هستند ولی فیلد شماره پرسنلی برای کلید اصلی مناسب تر است زیرا ممکن است بعضی از کارمندان کد ملی خود را دریههافت

نکرده باشند.

از کلید اصلی برای ایجاد ارتباط بین جداول مختلف استفاده می شود.در بخش آینده ایجاد ارتباط را فراخواهیم گرفت.

تنظیم یک یا چند فیلد به اعنوان کلید اصلی- 2.3.8 

تنظیم یک فیلد به اعنوان کلید اصلی

برای این منظور اعملیات زیر را انجام می دهیم:

 وارد نمای طراحی جدول «کارمندان» می شویم.1

رکورد شناسه کارمند را انتخاب می کنیم.2

Primary  کلیک راست کرده و گزینه برروی آیکون .۳  Key ه در انطور ک م. هم 2.۳.۴شکل  را انتخاب می کنی
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نشان داده ایم.

تنظیم چندفیلد به اعنوان کلید اصلی
زCtrlهمانند قبل وارد نمای طراحی شده و یک رکورد را انتخاب می کنیم و بهها نگه داشههتن کلیههد  ر را نی ورد دیگ ، رک

: انتخاب کلید اصلی2.3.4شکل 

1

2
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 را انتخاب می کنیم.Primary Keyانتخاب می کنیم و کلیک راست کرده، گزینه 

 شاخص گذاری یک فیلد- 2.3.9 

برای اینکار اعملیات زیر را انجام می دهیم:

 را انتخاب می کنیمTools>Index Designدر نمای طراحی جدول«کارمندان» مسیر .1

: شاخص گذاری2.3.5شکل 

1 2 3 4 ۵
با گذاشتن تیک، فیلد شناسه کارمند 

مجاز به تکرار داده نمی باشد

کادر لیست 
شاخص ها کادر تعیین شاخص برای جدول
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 کاربرد ایکون ها به صورت زیر است:2.۳.۵شکل در 

برای ایجاد شاخص جدید می باشد.)1(

برای حذف یک شاخص موجود می باشد.)2(

برای تغییر نام شاخص مورد نظر می باشد.)۳(

از این آیکون برای ذخیره تغییرات استفاده می شود.)۴(

برای برگشت به حالت اول استفاده می شود.)۵(

کلیک می کنیم. روی آیکون .2

 نام آن را «شاخص کدملی» می گذاریم..۳

در کادر تعیین شاخص فیلد کد ملی را از منوی کشویی انتخاب می کنیم..۴

)Ascendingفیلد را بر اساس کوچک به بزرگ مرتب سازی می کنیم.(.۵

 را فعال می کنیم.Uniqueگزینه ی .۶

 کلیک می کنیم.برای ذخیره تغییرات صورت گرفته روی آیکون .۷

 نشان داده ایم.2.۳.۶شکل همانطور که در 
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روابط میان جدول ها- 2.4 
 ایجاد رابطه بین جدول ها و انتخاب کلید خارجی مناسب- 2.4.1 

ابتدا برای ایجاد توانایی در مورد رابطه بین جداول و انتخاب کلید خارجی، انههواع رابطههه بیههن جههداول و کههاربرد کلیههد

خارجی را توضیح می دهیم.

:Baseرابطه ها در 

: ایجاد شاخص جدید2.3.6شکل 
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:1رابطه یک به یک

در رابطه یک به یک، هررکورد از جدول اول فقط می تواند با یک رکورد از جدول دوم رابطه داشته باشههد وهههر رکههورد از

جدول دوم نیز می تواند فقط با یک رکورد از جدول اول رابطه داشته باشد.رابطه یک  به یک مانند این است که یک جدول را بههه

دو جدول تقسیم کرده و برای ارتباط بین آن ها از فیلد کلید اصلی استفاده نموده باشیم.رابطه یک به یک کمتر مورد استفاده

قرار می گیرد.

موارد استفاده رابطه یک  به یک اعبارتند از:

هنگامی که فیلدهای یک جدول بسیار زیاد باشههند و بههرای بههالبردن سههراعت ذخیههره و بازیههابی بخههواهیم فیلههدها را•

دسته بندی کنیم.  به همین اعلت یک جدول را به جدول تقسیم می کنیم و فیلد کلید اصلی را در هر دو جدول تکرار

می کنیم تا کلید اصلی ارتباط بین دو جدول را برقرار کند.

هنگامی که یکسری از فیلدهای جدول مهم باشند و برای حفظ امنیههت بخههواهیم ایههن فیلههدها را در جههدول دیگههری•

ذخیره کنیم که افراد خاصی به این جدول دسترسی داشته باشند.در اینجا نیز جدول را به دو جدول تقسیم می کنیم

و فیلد کلید اصلی را در هردو جدول تکرار می کنیم تا کلید اصلی ارتباط بین دو جدول را برقرار کند.
:2رابطه یک به چند

در رابطه یک به چند، هررکورد جدول اول می تواند با چند رکورد از جدول دوم مرتبط باشد ولی هر رکورد از جدول دوم

می تواند فقط با یک رکورد از جدول اول مرتبط باشد.مثل یک رکورد شناسه دپارتمان در جدول «دپارتمههان» ممکههن اسههت بهها

1 One to One
2 One to Many
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چند رکورد جدول «کارمندان»ا رابطه داشته باشد ولی هر کارمند فقط متعلق به یک دپارتمان است.معمول فیلد کلید اصلی از

جدول اول با یک فیلد از جدول دوم این رابطه را برقههرار می کننههد کههه بههه فیلههد ارتبههاطی جههدول دوم کلیههد خههارجی گفتههه

می شود.رابطه یک به چند بسیار پرکاربرد است و در بیشتر بانک های اطلاعاتی از آن استفاده می شود.
:1رابطه چند به چند

در رابطه چند به چند، هر رکورد جدول اول می تواند با چند رکورد از جدول دوم مرتبط باشد و هر رکورد از جههدول دوم

نیز می تواند با چند رکورد از جدول اول مرتبط باشد.تنها روش برای ایجاد ارتباط چند  به چند بیههن دو جههدول، ایجههاد جههدول

سومی است که این ارتباط را ایجاد نماید و به جدول سوم جدول اتصال می گویند.  با ایجاد جدول اتصال درواقههع یههک رابطههه

چندبه چند را به دو رابطه یک به چند تبدیل می کنیم.

Baseکلید خارجی در 

یک کلید خارجی در یک جدول کلید اصلی در جدول دیگر است.

کلید خارجی را با یک مثال توضیح می دهیم، به دو جدول زیر نگاه کنید:

1Many to Many

:جدول دپارتمان2.4.1شکل 
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توجه کنید که ستون شناسه دپارتمان در جدول «دپارتمان» اشاره به ستون شناسه دپارتمههان در جههدول«کارمنههدان»

دارد.

ستون شناسه دپارتمان در جدول «کارمندان» کلید اصلی می باشد.

ستون شناسه دپارتمان در جدول «دپارتمان» کلید خارجی می باشد.

محههدودیت کلیههد خههارجی بههرای جلههوگیری از اقههداماتی کههه ارتبههاط بیههن دو جههدول را خههراب می کنههد اسههتفاده

می شود.همچنین محدودیت کلید خارجی از ورود داده های نامعتبر به ستون کلید خارجی جلوگیری می کند، زیرا داده ها باید

یکی از مقادیر جدولی باشند که کلید خارجی به آن ارجاع داده شده است.

حال با یادگیری انواع ارتباط بین جداول و کاربرد آن ها، همچنین یادگیری کلید خارجی در جداول بهها ذکههر یههک مثههال

توانایی ایجاد ارتباط بین جداول و انتخاب کلید خارجی را توضیح می دهیم.

برای ایجاد رابطه بین دو جدول، اعملیات زیر را انجام می دهیم:

همه جداول باز شده را می بندیم، زیرا بر روی جداول باز نمی توان رابطه ایجاد نمود..1

 را انتخاب می کنیم.Tools>Relationshipsمسیر.2

:جدول کارمندان2.4.2شکل 
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Addاگر تاکنون رابطه ای بین جدول ها تعریف نکرده باشیم، پنجره .۳  Tablesاهر ار ظ ورت خودک ه ص کل ب  مطابق ش

 از نوار ابزار کلیک می کنیم.)می گردد.(اگر این پنجره نمایش داده نشد بر روی دکمه

Addدر پنجره .۴  Tables ه رده و دکم کAdd جداولی که می خواهیم بین آن ها ارتباط برقرار کنیم انتخاب ک  را کلی

 نشان داده ایم.2.۴.۳شکل می کنیم. همانطور که در 

: اضافه کردن جدول برای ایجاد ارتباط2.4.3شکل 
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در این مرحله ارتباط بین جداول را ایجاد می کنیم.برای اینکار فیلدی را که می خواهیم از جههدول اول بهها جههدول دوم.۵

ارتباط برقرار کند درگ کرده و برروی فیلد مورد نظر در جدول دپارتمان رها می کنیم.

مثل می خواهیم رابطه بین جداول «محصول» و «دپارتمان» را ایجاد نماییم.بههرای اینکههار فیلههد شناسههه محصههول را از

جدول «محصول» درگ کرده و بر روی فیلد محصول جدول «دپارتمان» رها می کنیم.همین کار را برای فیلد شناسه دپارتمان

از جدول «دپارتمان» برای فیلد دپارتمان از جدول «کارمندان» انجام می دهیم.

برای باز شدن پنجره روابط ابتدا روی خط اتصال ارتباط بین جداول «محصول» و «دپارتمان» کلیک راسههت کههرده و.۶

 نشان داده ایم.2.۴.۴شکل  را انتخاب می کنیم. همانطور که در Editگزینه 

: طریقه باز کردن پنجره روابط2.4.4شکل 
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در پنجره ی باز شده جدول دپارتمان را انتخاب و فیلدهای محصول و شناسه محصول را انتخهاب می کنیهم. همهانطور.۷

 نشان داده ایم.2.۴.۵شکل که در 
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: پنجره تنظیم روابط2.4.5شکل 

1
2

انتخاب جدول برای ایجاد 
ارتباط

انتخاب فیلد برای ارتباط
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)1(Update Options

در اینجا ما می توانیم گزینه هایی که با تغییرات فیلد کلید اصلی روی آن اثر می گذارد را انتخاب کنیم.
No action

هرگونه تغییر در کلید اصلی در دیگر فیلدهای کلید خارجی تأ ثیر نمی گذارد.
Update cascade

اگر کلید اصلی تغییر یابد آنگاه تمام فیلدهای کلید خارجی نیز به روز رسانی می شود.
Set null

» می کند.IS NULLاگر کلید اصلی مربوطه اصلاح شده باشد استفاده از این گزینه مقدار فیلدهای کلید خارجی را «

IS NULL.یعنی فیلد خالی می باشد 
Set default

هنگامی که کلید اصلی اصلاح شود، استفاده از این گزینه یک مقدار پیش فرض را به فیلدهای کلیههد خههارجی در طههول

 اختصاص داده می شود.field Propertiesایجاد جدول مربوطه تعریف می کند.این مقدار پیش فرض در کادر 

)2(Delete options

 که با حذف فیلد کلید اصلی روی آن اثر می گذارد را انتخاب کنیم.در اینجا می توانیم گزینه هایی
No action

حذف یک فیلد کلید اصلی روی فیلدهای کلید خارحی اثر نمی گذارد.
Delete cascade

اگر فیلد کلید اصلی را حذف کنیم تمام فیلدهای کلید خارجی حذف خواهد شد.
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 حذف کنیم، تمام سوابق رکوردها ازDelete cascadeنکته:هنگامی که ما یک فیلد کلید اصلی را با تنظیمات 

جداول دیگر که به اعنوان کلید خارجی هستند حذف خواهد شد.در استفاده از این گزینه باید دقت کرد، زیککرا ممکککن

است بخش اعمده ای از داده های پایگاه داده حذف شود.

Set null

» به همه ی فیلدهای کلید خارجی اختصاص داده می شود.IS NULLاگر کلید اصلی مربوطه را حذف کنیم، مقدار «
Set Default

اگر کلید اصلی را حذف کنیم، مقدار پیش فرض به تمام فیلدهای کلید خارجی تنظیم می شود.

حال با توجه به یادگیری گزینه های موجود یکی از آن ها را که مورد نیاز است را انتخههاب می کنیههم. همههانطور کههه در.۸

 نشان داده ایم.2.۴.۶شکل 
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 تنظیمات را برای ارتباط جداول«کارمندان» و «دپارتمههان»، فیلههد شناسههه دپارتمههان از جههدول «دپارتمههان» و فیلههد.۹

دپارتمان از جدول «کارمندان» را انجام می دهیم.

: تنظیمات ارتباط2.4.6شکل 
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برای حذف رابطه ایجاد شده اعملیات زیر را انجام می دهیم:

برروی خطوط گرافیکی رابطه مورد نظر کلیک می کنیم تا رابطه انتخاب شود..1

 از صفحه کلید را فشار می دهیم.Deleteکلید .2

یکپارچگی روابط بین جداول- 2.4.2 

یکی از موارد مفید در ایجاد ارتباط حفظ یکپارچگی روابط بین جدول ها هست.اینکار بههااعث می شههود نرم افههزار صههحت

ارتباط را بررسی کند و همیشه تحت نظر داشته باشد.فرض کنید اگر در جدول«دپارتمان» بخواهیم شناسههه یههک محصههول را

وارد کنیم که این شناسه در جدول«محصول» وجود ندارد، قانون جامعیت یکپارچگی روابط این ارتبههاط را صههحیح نمی دانههد،

زیرا چنین محصولی در جدول «محصول» وجود ندارد.

برای ااعمال حفظ یکپارچگی برروی یک رابطه اعملیات زیر را انجام می دهیم:

 را انتخاب می کنیم.Editروی خطوط گرافیکی رابطه مورد نظر کلیک راست کرده و از منوی ظاهر شده گزینه .1

 را فعال می کنیم.Delete cascade و Update cascade برای فیلدهای مورد نظر گزینه Relationsدر پنجره .2

فرم-  3 
آشنایی با فرم و اجزای آن- 3.1 
 دلیل استفاده از فرم- 3.1.1 

مشاهده و ویرایش داده ها در جداول گاهی اوقات مشکل است.  به خصوص وقتی که اطلاعات را در چند جدول مرتبط
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1ذخیره کرده باشم.برای ساده ترشدن اعملیات ورود، ویرایش و حذف داده ها و کنترل بهتر داده های وارد شههده، از شههیء فههرم

استفاده می کنیم.

 باز کردن یک فرم برای تغییرات رکورد- 3.1.2 

 اعملیات زیر را انجام می دهیم:Baseبرای باز کردن یک فرم در نرم افزار 

 می رویم.Formsابتدا وارد نمای .1

ه Formsاز محیط .2 ه درOpen روی جدول «دپارتمان» کلیک راست کرده و گزین انطور ک م. هم اب می کنی  را انتخ

 نشان داده ایم. ۳.1.۴ و ۳.1.2شکل های 

1 Form
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: نمای فرم3.1.1شکل 



168هازه81صفحههجزوههیهآموزشیهمهارتهکارهباهنرمهافزارهپایگاههدادههها

آشنایی با منوهای فرم- 3.1.3 
 اجرا می شود صفحه ای همانند نرم افزار واژه پرداز مشاهده می کنیم کهBaseهنگامی که صفحه نمایش فرم در نرم افزار 

نوارابزار استاندارد و منوی آن همانند واژه پرداز می باشد.(در مهارت ششم مربوط به واژ ه پرداز فرا گرفتیم.)

در گوشه ی سمت چپ صفحه نمایش انواع کنترل های فرم را مشاهده می کنیم.  و در پایین صفحه، نوار ابزار کنههترل و

 نشان داده ایم.۳.1.۳ و ۳.1.۳نوار طراحی وجود دارد. همانطور که درشکل های 

: کلیک راست برای باز کردن جدول3.1.2شکل 
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: نمای فرم در حالت ورود داده3.1.3شکل 

نوار کنترل های فرم

نوار پیمایش

نوار ابزار طراحی فرم

رفتن به اولین صفحه

برگشت به صفحه قبل

رفتن به صفحه بعد

رفتن به صفحه آخر ساخت رکورد جدید برای ورود داده

ذخیره تغییرات

مشاهده جدول اصلی
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 استفاده از فرم برای تغییر محتویات یک رکورد- 3.1.4 
برای اینکار اعملیات زیر را انجام می دهیم:

 نشان داده ایم. ۳.1.۵شکل ، فرم «کارمندان» را با دوبار کلیک باز می کنیم. همانطور که در Formsابتدا در نمای .1

 با کلیک در رکوردهای جدول می توانیم تغییرات را انجام دهیم..2

: منوهای نوار کنترل3.1.4شکل 

ابزار فیلتر کردن
جست وجو پیشرفتهنوار پیمایش بازآوری

حذف رکورد موجود ابزار مرتب سازی
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جابه جایی بین رکوردها- 3.1.5 
برای جابه جایی بین رکوردها و ویرایش آن ها، اعملیات زیر را انجام می دهیم:

 نشان داده ایم.۳.1.۶شکل از دکمه های نوار پیمایش برای حرکت بین رکوردها استفاده می کنیم. همانطور که در .1

پس از انتقال به رکورد مورد نظر، برروی فیلدها، تغییرات لزم را ااعمال می کنیم..2

Forms: نمای 3.1.5شکل 
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 ذخیره و بستن یک فرم- 3.1.6 
اFile>Closeبعد از تغییرات دلخواه در فرم، مسیر   را انتخاب می کنیم.پیغام مبنی براینکه آیا تغییرات را ذخیره بکند ی

ه در Yesنه؟مشاهده خواهیم کرد که برای ذخیره برروی  انطور ک اییم.هم  نشههان۳.1.۸شکل و ۳.1.۷شکل  کلیک می نم

داده ایم.

: نوار پیمایش رکوردها3.1.6شکل 
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: بستن و ذخیره فرم3.1.7شکل 

1
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حذف یک فرم- 3.1.7 
 با حذف یک فرم، فقط فرم مربوطه حذف می شود و به داده  های وارد شده در جدول آسیبی نمی رسد.

برای حذف یک فرم، اعملیات زیر را انجام می دهیم:

 فرم مورد نظر را انتخاب می کنیم.Forms از محیط Formsدر نمای .1

 از صفحه کلید را فشار می دهیم.Deleteکلید .2

ابیDeleteدر پنجره محاوره ای ظاهر شده دکمه .۳  را کلیک می کنیم.باید توجه داشته باشیم، فرم حذف شده قابل بازی

نیست.

: پنجره محاوره ای ذخیره فرم3.1.8شکل 

1
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ایجاد فرم- 3.2 
ایجاد فرم از طریق ویزارد- 3.2.1 

اختنBaseساده ترین روش برای ایجاد فرم، استفاده از ویزارد است. در این روش نرم افزار   مرحله به مرحله ما را در س

فرم کمک می کند.

برای ایجاد فرم از طریق ویزارد، اعملیات زیر را انجام می دهیم:

 کلیک می کنیم. برروی Tasks محیط Formsدر نمای .1

Tablesاز قسمت .2  or  queries جدول مورد نظر را انتخاب می کنیم.جدول در قسمت ،Available  fieldsدهای  فیل

 نشان داده ایم.۳.2.1شکل جدول انتخابی ظاهر می شود. همانطور که در 

 کلیک می کنیم.جهت انتخههاب تمههام فیلههدهایبرای انتخاب فیلد مورد نظر، فیلد را انتخاب کرده و برروی دکمه.۳

 کلیک می کنیم.جدول بر روی دکمه 

: پنجره محاوره ای تایید حذف فرم3.1.9شکل 
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 را می زنیم.Nextدر اینجا تمام فیلدها را انتخاب می کنیم و دکمه 

Addدر مرحله بعد اگر فرم نیاز به زیر فرم داشته باشد گزینههه .۴  Subform رروی ا ب م.در اینج ال می کنی Next را فع

 توضیح داده خواهد شد.)۳.۴کلیک می کنیم.(آشنایی با زیرفرم ها و استفاده از آن ها در بخش

: پنجره ویزارد-مرحله اول انتخاب فیلدها3.2.1شکل 

تعیین جدول مورد نظر

محل فیلدهای قابل انتخابمحل فیلدهای انتخاب شده
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 کلیکNextدر مرحله بعد طراح بندی های مختلفی نمایش داده می شود.طراح بندی مورد نظر را انتخاب کرده و روی .۵

 نشان داده ایم.۳.2.2شکل می نماییم. همانطور که در 

در گام ششم گزینه هایی وجود دارد که می توان با استفاده آن ها بههه کههاربر اجههازه ورود یهها حههذف و اضههافه داده ههها را.۶

-طرح بندیForm Wizard: پنجره 3.2.2شکل 
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 نشان داده ایم.۳.2.۳شکل بددهیم. همانطور که در 

 نشان داده ایم. ۳.2.۴شکل در گام بعدی سبک و حاشیه فیلدها را در فرم مشخص می کنیم. همانطور که در .۷

Form Wizard: پنجره 3.2.3شکل 

تنها برای ورود داده 
هست.داده های موجود 

نمایش داده نمی شود

با فعال کردن این گزینه اجازه اضافه کردن 
داده را نداریم

با فعال کردن این گزینه اجازه حذف کردن 
داده را نداریم

با فعال کردن این گزینه اجازه اصلاح کردن 
داده را نداریم
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 نام فرم را وارد می کنیم.در اینجا نام فرم به طور پیش فرض همان نام جدولیName of the formدر گام آخر در فیلد .۸

که از آن فرم ساختیم می باشد.

 نشان داده ایم. ۳.2.۵شکل دوگزینه ی دیگر در این صفحه برای مرحله ی بعد از ایجاد فرم می باشد. همانطور که در 

-انتخاب سبک فرمform Wizard: پنجره 3.2.4شکل 
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 کلیک می کنیم.Finishبرروی دکمه .۹

ایجاد فرم در نمای طراحی- 3.2.2 

 فرم استفاده از طراحی فرم در نمای طراحی هست.فرم هایی را کههه بههه روش  ویههزارد ایجههاد1یکی از روش های طراحی

کردیم را می توانیم در نمای طراحی تغییر دهیم.همچنین می توانیم یک فرم را از ابتدا در نمای طراحی ایجاد کنیم.(البته این

1 Design

-انتخاب نام فرمForm Wizard: پنجره 3.2.5شکل 

بعد از ایجاد، فرم آماده 
ورود داده می باشد

بعد از ایجاد، فرم در حالت 
طراحی نشان داده می شود
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 هست.)FCDLکار نیاز به تجربه در زمینه کد نویسی دارد و خارج از مباحث استاندارد 

م.Editبرای باز کردن فرم در نمای طراحی ابتدا روی فرم مورد نظر کلیک راست کههرده و گزینههه  اب می کنی  را انتخ

 نشان داده ایم.۳.2.۷شکل همانظور که در 

توضیح دادیم.۳.1.۳ فرم همانند یک صفحه واژه پرداز می باشد که نوار ابزارهای موجود را در بخش 

: بازکردن فرم در نمای طراحی3.2.6شکل 
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طراحی فرم- 3.3 
انواع کنترل ها  در فرم- 3.3.1 

در جدول زیر انواع کنترل در نمای طراحی را شراح می دهیم:

: نمایش فرم در نمای طراحی3.2.7شکل 
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توضیحاتکنترل

(Selected)

 به حالتMouse با فعال کردن این آیکون اشاره گر 
انتخاب تغییر حالت می دهد.این کار برای انتخاب گروهی

از اشکال موجود در فرم مناسب می باشد.

(Design Mode On/Off)

برای تغییر از حالت طراحی به حالت استفاده ی کاربر از
این کنترل استفاده می شود.

(Form Properties)

مقدار تعیین شده را به صورت پیش فرض برای فیلد در نظر
می گیرد.در جاهایی کاربرد دارد که اگر کاربر داده ای را

وارد نکرد، فیلد مقدار پیش فرض داشته باشد.

(Check Box)
کنترل انتخابی برای فیلدهای بله و خیر

(Text Box)

یک فیلد متنی که به کاربر اجازه ورود متن را می دهد.در
یک فرم از فیلدهای متنی برای نمایش داده ها و ورود

داده ها استفاده می شود

(Formatted Field)

شبیه فیلد متنی است که می توان ورودی و خروجی فرمت
را تعریف کرد

این تابع می تواند برای اجرای یک دستور یا رویداد تعریف
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(Push Bottun)شود مانند اجرای دستور در صورت کلیک کردن
ما می توانیم متن و گرافیک به این دکمه ااعمال کنیم

(Option Button)

ایجاد دکمه های گزینه برای کاربر و قابلیت انتخاب تنها
یکی از گزینه ها

(List Box)

 به ما این امکان را می دهد که لیستی از ورودی ها را
داشته باشیم در صورتی که این کنترل را به پایگاه داده
متصل کنیم.لیست به طور خودکار ظاهر خواهد شد. 

(Combo Box)

ایجاد یک لیست کشویی که کاربران حق انتخاب یک
گزینه را دارند.

(Label Fields)

ایجاد یک فیلد برای نمایش متن، در واقع یک برچسب
برای نمایش متن از پیش تعریف شده می باشد.

(More Controls)

 با فعال کردن این گزینه تعدادی از کنترل های دیگر
نمایش داده می شود.

(Form Design)
نوار ابزار طراحی فرم باز می شود.

(Wizards On/Off)
کنترل ویزارد به شکل خودکار روشن و خاموش می شود.
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(Spin Button)

این کنترل برای فیلدهای اعددی کاربرد دارد به این شکل
که مقدار فیلد می تواند توسط اشاره گر ماوس قابل تنظیم

باشد

(Scroll bar)
برای ایجاد نوار پیمایش صفحه استفاده می شود.

(Image Button)
یک دکمه برای نمایش تصویر مورد نظر ایجاد می کند.

(Image Control)

یک کنترل برای اضافه کردن تصاویر از یک پایگاه داده
ایجاد می کند.

(Date Field)
یک فیلد برای ورود تاریخ ایجاد می کند.

(Time Field)
یک فیلد برای ورود زمان ایجاد می کند.

(File Selection)
یک دکمه برای انتخاب فایل ایجاد می کند.

(Numerical Field)
یک فیلد اعددی برای ورود اعدد ایجاد می کند.
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(Currency Field)
یک فیلد برای ورود قیمت و هزینه ایجاد می کند.

(Pattern Field)

 تعیین می کند کهEdit maskفیلد الگو ایجاد می کند.
داده می تواند وارد شود.

(Group Box)
یک کنترل گروهی ایجا می کند.

(Table Control)
جدول بانک اطلاعاتی را برای نمایش ایجاد می کند.

(Navigation bar)

نوار پیمایش برای حرکت بین رکوردها، فیلتر کردن و
مرتب کردن فیلدها را ایجاد می کند.

: انواع کنترل های فرم3:1جدول 

استفاده از پیمایش گر فرم در طراحی فرم- 3.3.2 

در طراحی فرم برای راحتی کار در هنگام رفتن به رکورد بعد یا ایجاد رکورد جدید می توان از پیمایش گر فههرم اسههتفاده

کرد.برای اینکار:

 به قسمت ویرایش فرم می رویم.Edit با کلیک راست برروی فرم و انتخاب گزینه Formsاز نمای .1

۳.۳.1شکل  کلیک می کنیم و نوار پیمایش را با دراگ کردن رسم می کنیم. همههانطور کههه در بر روی آیکون  .2
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نشان داده ایم.

 نتیجه کار را مشاهده می کنیم. با کلیک برروی .۳

اضافه کردن  سرصفحه و پاصفحه در فرم- 3.3.3 
 ابتدا فرم را باز می کنیم سپس اعملیات زیر را انجام می دهیم:

 انتخاب می کنیم.Insert>Header را از مسیر Defualt Style برای اضافه کردن سر صفحه گزینه .1

 را انتخاب می کنیم.Insert>Footer>Defualt Styleبرای اضافه کردن پا صفحه مسیر .2

 نشان داده ایم.۳.۳.2شکل  همانطور که در 

: استفاده از پیمایش گر برای فرم3.3.1شکل 
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زیر فرم ها- 3.4 
 موارد استفاده از فرم های دارای زیرفرم- 3.4.1 

در جدول هایی که با یکدیگر ارتباط دارند، لزم است فرم هایی را ایجاد نمود که جداول مرتبط به هم در یک فرم نمایش

داده شوند.مثل کاربر، کد دپارتمان در جدول «کارمندان» و جزئیات کد دپارتمان را در یک فرم مشاهده کنههد.نرم افههزار بههرای

: اضافه کردن سرصفحه و پا صفحه3.3.2شکل 
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ا استفاده می کند.1ایجاد چنین فرم هایی از زیرفرم ها 

ایجاد زیر فرم از طریق ویزارد- 3.4.2 

برای ایجاد اینگونه فرم ها می توانیم از طریق ایجاد فرم به روش ویزارد که در ابتدای فصل فراگرفتیم استفاده کنیههم.در

ایجاد چنین فرم هایی باید به دونکته زیر توجه کرد:

رابطه میان جداول را باید قبل از ایجاد فرم ایجاد کرده باشیم.•

در هنگام انتخاب فیلدها برای ایجاد فرم باید فیلدهای جداول مرتبط به هم را انتخاب نمود.•
برای ایجاد زیر فرم مراحل زیر را انجام می دهیم:

 کلیک می کنیم.بر روی  .1

 توضیح داده شد.2.2.1در پنجره فرم ویزارد جدول کارمندان را انتخاب می کنیم.همانند بخش .2

Addدر مرحله ی بعد برای ایجاد زیرفرم گزینه .۳  Subform ه در انطور ک م.هم ال می کنی  نشههان۳.۴.1شکل  را فع

داده ایم.

1 Subforms
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۳.۴.2شکل در گام سوم جدولی که می خواهیم به اعنوان زیرفرم ایجاد شود را انتخههاب می کنیههم. همههانطور کههه در .۴

نشان داده ایم.

: فعال کردن زیرفرم3.4.1شکل 
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در گام بعدی فیلدی که در زیرفرم به اعنوان کلید اصلی ارتباط داده شده است را بههه فیلههد مربههوطه در جههدول اصههلی.۵

 نشان داده ایم.۳.۴.۳شکل به هم مرتبط می کنیم. همانطور که در 

: انتخاب جدول برای زیرفرم3.4.2شکل 



168هازه105صفحههجزوههیهآموزشیهمهارتهکارهباهنرمهافزارهپایگاههدادههها

 نشههان۳.۴.۴شکل در گام بعدی طراح بندی مناسب برای جدول اصلی و زیر فرم انتخاب می کنیم.همههانطور کههه در .۶

داده ایم.

: ارتباط جدول زیرفرم با جدول اصلی3.4.3شکل 
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 می کنیم.Nextبدون تغییر Select the data entry modeدر پنجره .۷

 نشان داده ایم.۳.۴.۵شکل  سبک و حاشیه ی مورد نظر را انتخاب می کنیم. همانطور که در Apply Stylesدر پنجره .۸

: انتخاب طرح بندی3.4.4شکل 
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در مرحله ی آخر نام فرم و نحوه نمایش فرم بعد از ایجاد آن را انتخاب می کنیم..۹

 نشان داده ایم.۳.۴.۶شکل  کلیک می کنیم.نتیجه را در Finishبرروی دکمه .1۰

: انتخاب سبک فرم3.4.5شکل 
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 ایجاد زیر فرم در نمای طراحی- 3.4.3 
برای ایجاد زیر فرم در نمای طراحی اعملیات زیر را انجام می دهیم:

 به نمای طراحی «فرم کارمندان» می رویم..1

) کلیک می نماییم.Form Navigator (در نوار طراحی فرم روی آیکون  .2

تMainFormدر پنجره باز شده فرم ایجاد شده و کنترل های آن نمایش داده شده است بههر روی گزینههه .۳ ک راس  کلی

جدول زیرفرم

: نتیجه ایجاد زیرفرم3.4.6شکل 
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 نشان داده ایم. ۳.۴.۷شکل کرده و یک فرم جدید ایجاد می کنیم. همانطور که در 

٫نام فرم را «زیر فرم» می گذاریم.۴

Propertiesبرای اینکه به زیرفرم، جدول موردنظر را ارتباط بدهیم ابتدا روی فرم زیرفرم کلیک راست کرده و گزینههه .۵

-ایجاد فرم جدیدForm Navigator: پنجره 3.4.7شکل 
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را انتخاب می کنیم.

 را جدول «دپارتمان» انتخاب می کنیم.Content، فیلد Dataدر پنجره باز شده در تب .۶

 را انتخاب می کنیم.Link master fieldsبرای ایجاد ارتباط فیلد کلید اصلی جدول «دپارتمان» با جدول اصلی گزینه .۷

 نشان داده ایم.۳.۴.۸شکل همانطور که در 

Linkدر پنجره .۸  fieldsرار اط برق دان ارتب دول کارمن  بین شناسه دپارتمان از جدول دپارتمان و فیلد دپارتمان از ج

 نشان داده ایم.۳.۴.۹شکل می کنیم. همانطور که در 
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: تنظیم خصوصیات زیرفرم3.4.8شکل 

1
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 را می بندیم.Form Propertiesبعد از آن پنجره .۹

) کلیک می کنیم.Add field (برای ایجاد فیلدهای زیرفرم در فرم روی آیکون .1۰

شکل در پنجره ی باز شده فیلدها را با دوبار کلیک روی آن ها به صفحه نمایش فرم انتقال می هیم. همانطور کههه در .11

 نشان داده ایم. ۳.۴.1۰

: ایجاد لینک جدول اصلی و زیرفرم3.4.9شکل 
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 نشان داده ایم.۳.۴.11شکل  کلیک می نماییم. همانطور که در برای مشاهده نتیجه تغییرات روی آیکون .12

: ایجاد فیلدبرای زیرفرم3.4.10شکل 
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بازیابی اطلاعات-  4 
جست وجوی اطلاعات- 4.1 
استفاده از جست وجو و فیلتر در جدول یا فرم- 4.1.1 

جست وجو کردن:

Findبرای یافتن اطلاعات موردنظر در بانک اطلاعاتی، می توانیم از پنجره   Recordای ر در بانک ه  استفاده نماییم.اگ

design Mode: گزینه 3.4.11شکل 

کلیک برروی این دکمه
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Findاطلاعاتی رکوردهای زیادی وجود داشته باشد، پنجره   Recordود را  به ما کمک می کند به سراعت اطلاعات مورد نظر خ

بیابیم.

برای جست وجو در یک جدول، اعملیات زیر را انجام می دهیم:

 کلیک می کنیم.در نمای ورود داده در فرم روی آیکون .1

 نشان داده ایم.۴.1.1شکل از پنجره باز شده تغییرات دلخواه را انجام می دهیم. همانطور که در .2
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فیلتر کردن:
این روش را در بخش های قبل فرا گرفتیم.

Find Record: پنجره 4.1.1شکل 

جست وجو براساس متن
جست وجو فیلدهای خالی

جست وجوی فیلدهایی که 
خالی نیست

انتخاب محدوده جست وجو

تنظیمات جست وجو



168هازه117صفحههجزوههیهآموزشیهمهارتهکارهباهنرمهافزارهپایگاههدادههها

پرس وجو ها- 4.2 
آشنایی با مفهوم پرس وجو و موارد استفاده از آن- 4.2.1 

، جهههت اسههتخراج اطلاعههات جههداول بانههک اطلاعههاتی به کههار می رود.پرس وجههو می توانههد زیرمجمههواعه ای از1پرس وجو

رکوردهای یک یا چند جدول را شامل شود.پرس وجو را از لحاظ مفهومی می توان مشابه یک جدول مجههازی دانسههت، جههدولی

لا به شکل جدول وجود ندارد.در واقههع جههداول سههاختار فیزیکههی ذخیههره اطلاعههات هسههتند ولههی که مشاده می شود ولی واقع

هBaseپرس وجوها جداول منطقی هستند که از روی جداول فیزیکی ساخته می شوند.معمول نرم افزار  دول ب  با پرس وجو و ج

طور یکسان رفتار می کند.  به اعنوان مثال ساختن فرم برای یک جدول و یک پرس وجو به یک شیوه انجههام می شههود یهها روش

فیلتر کردن جداول و پرس وجوها تفاوتی نمی کند.

آشنایی با انواع پرس وجو- 4.2.2 

انواع مختلف پرس وجو در بانک اطلاعاتی اعبارتند از:

•Make Table: 

نواعی پرس وجو هست که پس از انجام جست وجو، نتیجه را در یک بانک اطلاعاتی و جدول دیگر به دلخواه شما ذخیره

می نماید.

•Append Query: 

اطلاعات ذخیره شده را از یک بانک اطلاعاتی که از سایرین دریافت نموده ایم یا در اختیار داریم، جستجو و نتیجه را به

جدول موجود در نرم افزار ما اضافه می کند.

1 Queries
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•Update Query: 

با این پرس وجو می توانیم اگر اطلاعاتی به جدول اضافه کرده ایم را به روز رسانی کنیم.

•Crosstab Query: 

اطلاعات را طبقه  بندی می کند.

•Delete Query: 

می توانیم یک پرس وجو ایجاد کنیم که اطلاعات خاصی را از جدول ما حذف نماید.

 ایجاد پرس وجو از طریق ویزارد- 4.2.3 
برای ایجاد پرس وجو از طریق ویزارد اعملیات زیر را انجام می دهیم:

 کلیک می کنیم. برروی Tasks از پنجره Queriesدر نمای .1

 جدول «کارمندان» را انتخاب و همه ی فیلدها را به کادر سمت راست منتقل می کنیم.Query Wizardدر پنجره .2

در مرحله دوم فیلد نام خانوادگی را براساس کوچک به بزرگ مرتب سازی می کنیم..۳

 نمایش داده شده۴.2.1شکل در گام سوم شرط لزم برای ایجاد پرس وجو را مشخص می کنیم.شرط های موجود در .۴

ه در Nextاست. شرط مورد نظر با مقدار شرط را انتخاب می کنیم و برروی  انطور ک م. هم ک می کنی شکل  کلی

 نشان داده ایم. ۴.2.2
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٫

: شرط های پرس وجو4.2.1شکل 
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در گام چهارم دوگزینه وجود دارد که با فعال کردن گههزینه ی اول بعههد از سههاخت پرس وجههو تمههام رکوردههها نمههایش.۵

داده می شود و اگر گزینه ی دوم فعال شود تنها نتیجه پرس وجو و دسههتورالعمل آن اجههرا می شههود.همههانطور کههه در

 نشان داده ایم.۴.2.۳شکل 

: پنجره ایجاد شرط برای پرس وجو4.2.2شکل 
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نکته:گام پنجم و ششم زمانی فعال می شود که ما گزینه ی دوم را انتخاب کنیم.اگر فیلد اعددی در میان فیلدهای انتخاب شههده

وجود داشته باشد، در مرحله بعدی می توان تعیین کرد که مجموع، مینیمم، ماکزیمم یا میانگین یک فیلد مجزا نمایش داده شود.

: انتخاب نوع پرس وجو برای نمایش4.2.3شکل 

نمایش همه فیلدها و رکوردها

نمایش خلصه

تنظیمات مربوط به نمایش 
خلصه

ایجاد فیلد جدید در قسمت 
تنظیمات نمایش خلصه
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 کلیک می نماییم.Nextگام هفتم مربوط به اختصاص نام مستعار برای فیلدها هست.برروی .۶

گام آخر نام پرس وجههو را تعییههن می کنیههم و همچنیههن نحههوه نمههایش بعههد از ایجههاد را تعییههن می کنیههم و در کههادر.۷

Overview نشان داده ایم. ۴.2.۴شکل  خلصه اعملیات انجام شده را به ما نمایش می دهد. همانطور که در 

: گام اخر ایجاد پرس وجو از طریق ویزارد4.2.4شکل 
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ایجاد پرس وجو از طریق نمای طراحی- 4.2.4 
برای ایجاد پرس وجو از طریق نمای طراحی اعملیات زیر را انجام می دهیم:

 کلیک می نماییم. برروی Tasks در محیط Queryدر نمای .1

Addپنجره اضافه کردن جدول یا پرس وجو نمایش داده شده، با انتخاب جدول «کارمنههدان» وکلیههک بههرروی گزینههه .2

 نمایش داده نشد از محیط طراحی باAdd Tables Or Queryجدول را به محیط طراحی اضافه می کنیم.اگر پنحره 

 نشان داده ایم. ۴.2.۵شکل  آن را باز می کنیم. همانطور که در کلیک برروی آیکون 

 به صفحه ی طراحی می رویم.Close بعد از اضافه کردن جداول مورد نظر با کلیک برروی .۳

نمای طراحی پرس وجو شامل نوار ابزار طراحی، بخش نمایش جدول و بخش انتخهاب فیلههدها و تعییههن شهرط هسهت.

 نشان داده ایم. ۴.2.۶شکل همانطور که در 

Add Table: انتخاب آیکون 4.2.5شکل 

1
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: نمای طراحی پرس وجو4.2.6شکل 

نوار ابزار طراحی

بخش نمایش جدول

بخش انتخاب فیلدها و 
تعیین شرایط
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اعملکردسظر

Fieldفیلدی را که می خواهیم در پرس وجو نمایش داده شود یا برروی آن
شرطی را قرار دهیم از طریق این سطر انتخاب می کنیم.

Aliasبرای اضافه کردن نام مستعار به فیلدها در پرس وجو از این استفاده
می کنیم.

Tableنام جدول مربوط به فیلد انتخاب شده، به صورت خودکار در این سطر
قرار می گیرد.

Sortنحوه مرتب سازی رکوردها براساس فیلد انتخاب شده را تعیین
 باشد.3 یا مرتب نشده2، نزولی1می کند.مرتب سازی می تواند صعودی

Visibleدر صورتی که این گزینه انتخاب شود، فیلد در پرس وجو ساخته شده
نمایش داده می شود.اگر بخواهیم برروی یک فیلد شرط بگذاریم ولی آن

را نمایش ندهیم، گزینه را غیرفعال می کنیم.

Function.درصورت نیاز ازاین سطر می توان برای اجرای توابع استفاده نمود

Criterionشرط مورد نظر بررپی فیلد را دراین سطر درج می کنیم، شرط هایی که
And فیلدهای مختلف درج می شوند، با یکدیگر criteriaدر قسمت 

1 Ascending
2 Descending
3 Not Sort
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می شوند.

Or به وسیله این سطر می توان شرط به صورتOr.ایجاد کرد 

: سطرها و عملکرد آنها در نمای طراحی پرس وجو4:1جدول 

ایینFieldفیلدهای مورد نظر را از سطر .۴  انتخاب می کنیم.یا می توان با دوبار کلیک روی فیلدهای جدول آن ها را به پ

منتقل کرد.

خصSortاگر بخواهیم روی فیلد انتخاب شده مرتب سازی انجام شود، در سطر .۵ ازی را مش وع مرتب س  همان فیلد، ن

می کنیم.

 فیلدهایی را که می خواهیم در جدول حاصل از پرس وجو نمایش داده شوند، انتخاب می کنیم.Visibleدر سطر .۶

در صورتی که بخواهیم برروی یک فیلد شرطی را قرار دهیههم تهها فقههط رکوردهههایی کههه ایههن شههرط را دارنههد نمههایش.۷

رطی در Criteriaداده شوند، در سطر  ای ش م. اعملگره ایپ می کنی  نشهان۴:2جدول  آن فیلد شرط مورد نظر را ت

داده ایم.



168هازه127صفحههجزوههیهآموزشیهمهارتهکارهباهنرمهافزارهپایگاههدادههها

اگر شرط برقرار بودمعنی اعلمتاعلمت

=equal to(مساوی) 
فیلد یکسان با مقدار مشخص

برمی گرداند.

<>not equal to(نامساوی) 
فیلدی به غیر از اعنوان گفته شده

نمایش داده می شود

<greater than(بزرگ تر از) 
فیلد بزرگ تر از مقدار مشخص شده

را نمایش می دهد.

>less than(کوچکتر از) 
فیلد کوچکتر از مقدار مشخص

شدهرا نمایش می دهد.

<=greater than or equal
to(بزرگتر یا مساوی از)

فیلد بزرگ تر یا مساوی مقدار
مشخص شده را نمایش می دهد.

>=less than or equal to

(کوچکتر یا مساوی از)
فیلد کوچکتر یا مساوی مقدار

مشخص شده را نمایش می دهد.

Betweenبین دو رکورد
رکوردهای بین دو مقدار را برمی

گرداند

Like «مثال «تLikeرکوردهایی که با حرف ت شروع
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می شوند را نمایش می دهد.    

: عملگرهای شرطی4:2جدول 

 به طور مثال می خواهیم افرادی که نام خانوادگی آن ها غیر از «اعارف منش» هست را جست وجو کنیههم.ابتههدا در سههطر

Criteriaon.اعلمت <> را در ستون نام خانوادگی وارد و کلمه «اعارف منش» را تایپ می کنیم 

 کلیک می کنیم.برای ذخیره و انتخاب نام پرس وجو برروی آیکون .۸

پنجره طراحی را می بندیم و با دوبار کلیک برروی پرس وجوی ایجاد شده نتیجه اعملیات را مشاهده می کنیم..۹

 نشان داده ایم. ۴.2.۷شکل همانطور که در 
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ایجاد پرس وجوی چند جدولی- 4.2.5 
در هنگام ایجاد پرس وجو در نمای طراحی، می توان چند جدول مرتبط به هم را در این پرس وجو شرکت داد و پرس وجو

کاربردی تری را ایجاد کرد.

 به طور مثال می خواهیم به کمک ایجاد پرس وجو، لیست کارمندانی که در دپارتمان آموزش هستند و نام محصههول آن

دپارتمان را به ترتیب نام خانوادگی نمایش دهیم.در این لیست فقط شناسه کارمند، نام و نام خانوادگی، نههام دپارتمههان و نههام

: نمای طراحی پرس وجو4.2.7شکل 

1

انتخاب فیلدها

2

3

4
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محصول نمایش داده شود.

در نگاه اول شاید ایجاد این پرس وجو کمی مشکل به نظر رسد ولی با کمی تأمل به راحههتی می تههوان ایههن پرس وجههو را

ایجاد نمود.همانطور که مشاهده می شود فیلدهایی که در پرس وجو شرکت دارند فیلههدهایی از جههداول «کارمنههدان» (شناسههه

کارمند، نام و نام خانوادگی)، «دپارتمان»(نام دپارتمان) و «محصول» (نام محصول) هستند.پس باید جههداول فههوق را هنگههام

ایجاد پرس وجو انتخاب نماییم.

برای ایجاد این پرس وجو، اعملیات زیر را انجام می دهیم:

 کلیک می نماییم. روی Queriesدر نمای .1

Addپنجره .2  Table  Or  Queriesردن ک ک  ظاهر می شود.جداول «کارمندان»، «دپارتمان» و «محصول» را با کلی

لل در قسمت Addدکمه  اطRelationships، در پنجره طراحی نمایش می دهیم.در اینجا چون ما قب  بین جداول ارتب

برقرار کردیم هنگامی که جداول را اضافه می کنیم با همان ارتباط ظاهر خواهد شد.

در پنجره طراحی فیلدهای شناسه کارمند، نام و نام خانوادگی را از جدول «کارمندان» انتخاب می کنیم.فیلد شناسههه.۳

دپارتمان و نام دپارتمان را از جدول «دپارتمان» انتخاب می کنیم.فیلههد نههام محصههول را هههم از جههدول «محصههول»

انتخاب می کنیم.

 را برای همه فیلدها به جز شناسه دپارتمان که قرار نیست نمایش داده شود، را فعال می کنیم.Visibleگزینه .۴

) در نظر می گیریم.Ascendingنحوه مرتب سازی فیلد نام خانوادگی را صعودی (.۵

 تایپ می کنیم.Criteria=» را برای فیلد شناسه دپارتمان در سطر ۹شرط «.۶
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 نشان داده ایم. ۴.2.۸شکل همانطور که در 

 اضافه کردن معیاری به پرس وجو- 4.2.6 
مثال قبل را در نظر بگیرید، ما برای شناسه دپارتمان شرط گذاشتیم تا کسانی که در دپارتمان آموزش هستند را به مهها

نشان دهد. حال می خواهیم کسانی که در دپارتمان آموزش هستند و نههام خههانوادگی آن ههها «حههاجی زاده» نیسههت را نمههایش

دهیم:

: وارد کردن فیلدها و شرایط آن در پنجره طراحی پرس وجو4.2.8شکل 

1

2

3 4

۵

6
وارد کردن فیلدها
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ارت «Criteriaبرای اینکار مطابق مثال قبل پرس وجو را ایجاد می کنیهم فقهط در سهتون نهام خهانوادگی و سهتون   اعب

 نشان داده ایم.۴.2.۹شکل حاجی زاده <>» را تایپ می کنیم. همانطور که در 

Run (برای نمایش نتیجه ی تغییرات در نمای طراحی برروی آیکون   Queryردن ا فش  ) کلیک می کنیم. و یا ب

 نشان داده ایم.۴.2.1۰شکل  از صفحه کلید این پرس وجو را اجرا می کنیم.همانطور که در F5دکمه 

: ایجاد عملگر در پرس وجو4.2.9شکل 
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: اجرای پرس وجو در نمای طراحی4.2.10شکل 



جزوههیهآموزشیهمهارتهکارهباهنرمهافزارهپایگاههدادههها168هازه134صفحهه

 در پنجره طراحی پرس وجو آمده است:OR و ANDدر جدول زیر نحوه استفاده از اعملگرهای منطقی 

استفاده در دو فیلداستفاده در یک فیلداعملگر

ORیک شرط را در قسمت
Criteriaو دیگری را در 

 همان فیلدORقسمت 
می نویسیم

Criteriaیک شرط را در قسمت 

فیلد اول و شرط دوم را در قسمت
ORفیلد دوم می نویسیم 

ANDهر دوشرط را در قسمت
Criteriaفیلد می نویسیم و 

 راANDبین دوشرط اعبارت 
تایپ می کنیم.

Criteriaیک شرط را در قسمت 

فیلد اول و شرط دوم را درقسمت
Criteria.فیلد دوم می نویسیم 

: حالت های مختلف استفاده از عملگرهای منطقی4:3جدول 

برای مثال می خواهیم کسانی که نام آن ها «مجید» یا نام دپارتمان آن ها«آموزش» هست را در پرس وجو ایجاد کنیم:

 نشان داده ایم.۴.2.11شکل روند ایجاد فیلدها همانند مثال قبل می باشد.همانطور که در 

 باید استفاده شود:ORدر اینجا از اعملگر 
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کاراکتر * به معنی هر می باشد.

 استفاده می شود.likeکاراکتر ٪ برای اعملگر 

: ایجاد پرس وجو با عملگر منطقی4.2.11شکل 
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ویرایش یک پرس وجو- 4.2.7 
زینه ی Queriesبرای ویرایش یک پرس وجو ابتدا در نمای  رده و گ ت ک  راEdit روی پرس وجوی مورد نظر کلیک راس

انتخاب می کنیم.
حذف شرط:

 را از صفحه کلید فشار می دهیم.Deleteبرای حذف شرط، ابتدا آن را انتخاب کرده و کلید 
اضافه کردن فیلد:

روی فیلد موردنظر دوبار کلیک کرده و آن را به پایین منتقل می کنیم.
حذف فیلد یا اصلاح:

ارDeleteبرروی ستون مورد نظر کلیک کرده و آن را اصلاح می کنیههم و یهها بههرای حههذف کلیههد  فحه کلید فش  را از ص

می دهیم.

آشنایی با تجزیه و تحلیل پرس وجو- 4.2.8 
تجزیه وتحلیل یک پرس وجو به اعنوان یک فرآیند در پایگاه داده محسوب می شود که به منظور بهینه سازی اعملکرد مورد

استفاده قرار می گیرد. تجزیه وتحلیل پرس وجو به بهبود کارایی کلی پردازش و سراعت اعملکرد پایگاه داده کمک می کند.

استفاده از پرس وجو در فرم- 4.3 
 موارد لزوم استفاده از پرس وجو در فرم ها- 4.3.1 

در بعضی مواقع ما باید فیلدهایی در جداول مختلف را در یک فرم بیاوریم و یا نتیجه پرس وجوی ایجاد شده را در نمای
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فرم دربیاوریم.در اینگونه موارد ما از پرس وجو در فرم استفاده می کنیم.

 استفاده از یک پرس وجو در فرم- 4.3.2 

برای اینکار اعملیات زیر را انجام می دهیم:

ابتدا پرس وجو با فیلدهای مورد نظر را ایجاد می کنیم..1

 می شویم.Form Wizardوارد پنجره .2

پرس وجوی مورد نظر را انتخاب می کنیم..۳

تمامی فیلدها را انتخاب می کنیم و به مرحله بعد می رویم..۴

 چون فرمی که می خواهیم ایجاد کنیم از پرس وجو گرفته شده دیگر نیازی به زیر فرم ندارد.  به مرحله بعد می رویم..۵

در گام پنجم نحوه نمایش آن در فرم را انتخاب می کنیم..۶

همانطور که در بخش فرم فراگرفتیم بقیه مراحل را طبق سلیقه خودمان انجام می دهیم..۷

 نشان داده ایم. ۴.۳.1شکل همانطور که در 
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گزارش -  5 
آشنایی با مفهوم گزارش- 5.1 
موارد استفاده از گزارش- 5.1.1 

هدف نهایی از ایجاد بانک اطلاعاتی، استخراج اطلاعات مورد نیاز از بانک اطلاعاتی هست. در واقع مزیههت مهههم بانههک

اطلاعاتی این است که اطلاعات مورد نیاز در زمان بسیار کوتاهی در قالب گزارش هههای دلخهواه در اختیههار مهها قههرار می دهههد.

گزارش به سندی گفته می شود که اطلاعات آن به صورت ساخت یافته برروی صفحه نمایش یا کاغذ قابل مشههاهده هسههت.  بههه

: نتیجه استفاده پرس وجو در فرم4.3.1شکل 
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می نامیم.1اعبارتی ساده تر، استخراج اطلاعات را از جداول و پرس وجوها در قالب لیست های متنی، آمار و نمودار، گزارش 

 باز کردن یک گزارش- 5.1.2 

برای باز کردن یک گزارش اعملیات زیر را انجام می دهیم:

 می رویم.Reports به نمای .1

 را انتخاب می کنیم.Open برروی گزارش مورد نظر کلیک راست کرده و گزینه Reportsدر محیط .2

 و یا با دوبار کلیک روی گزارش می توان آن را باز کنیم.

قسمت های مختلف یگ گزارش- 5.1.3 

 روبرو می شویم:۵.1.1شکل هنگام باز کردن گزارش، با 

1 Report
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ه بها فحه نمهایش گهزارش نیهز هماننهد نرم افهزار واژه پهرداز هسهت ک همانند صفحه نمایش فرم که واژه پرداز بهود، ص

قسمت های مختلف آن در مهارت کار با واژه پرداز آشنا شدیم.

خروجی گرفتن از گزارش- 5.1.4 

ر راFile>Exportبرای گرفتن خروجی از گزارش مسیر  ورد نظ ل م وع فای ده ن  را انتخاب می کنیم.از پنجره ی باز ش

 نشان داده ایم.۵.1.2شکل انتخاب می کنیم. همانطور که در 

: نمای گزارش5.1.1شکل 

با کلیک برروی این گزینه حالت ویرایش 
گزارش نمایش داده می شود

نمایش گزارش ایجاد شده
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 در نوار ابزار استاندارد استفاده می کنیم. بود می توانیم از آیکون PDFاگر نیاز به خروجی 

توانایی ایجاد گزارش- 5.2 
 ایجاد گزارش از طریق ویزارد- 5.2.1 

برای ایجاد گزارش از طریق ویزارد اعملیات زیر را انجام می دهیم:

: پنجره محاوره ای خروجی گزارش5.1.2شکل 

1

2

انواع خروجی
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 کلیک می کنیم. برروی Tasks در محیط Reportدر نمای .1

 نیز ظاهر خواهد شد که فیلدهایAdd Field یک پنجره ی کوچک به نام Report Wizardاعلوه بر نمایش پنجره ی .2

یک جدول را به اعنوان پیشنهاد نمایش داده است و در صورت نیاز آن ها را با دوبار کلیک روی فیلدها اضافه می کنیم.

 را می بندیم.Add Fieldپنجره .۳

۵.2.1شکل ، جدول یا پرس وجوی موردنظر را انتخاب می کنیم.همانطور که در Report Wizardدر گام اول پنجره .۴

نشان داده ایم.

: انتخاب فیلد برای ایجاد گزارش5.2.1شکل 
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گام دوم برای ایجاد برچسب و انتخاب نام برای فیلدها می باشد که در صورت نیاز نههام آن ههها را تغییههر می دهیههم.روی.۵

Next.کلیک می کنیم 

مرحله ی سوم برای ایجاد سرگروه برای نمایش گزارش می باشد.به این صورت که اگر فیلدی در اینجا انتخاب شههود آن.۶

ان راHeatherفیلد به اعنوان   در بالی هرکدام از رکوردهای مربوط به گزارش قرار می گیرد.در اینجا فیلد نام دپارتم

 کلیک می کنیم.Nextبه کادر سمت راست منتقل کرده و روی 

گام چهارم برای مرتب سازی فیلدها می باشد.  چون ما نام دپارتمان را به اعنوان سرگروه انتخاب کردیههم در فیلههد اول.۷

نام دپارتمان را مشاهده می کنیم که باید مرتب شده باشد.در فیلدهای بعدی می توان فیلدهای دیگر را مرتب کرد.

شکل در گام پنجم لیه های مختلف گزارش و چگونگی نمایش برگه ی گزارش را تعیین می کنیههم. همههانطور کههه در .۸

 نشان داده ایم.۵.2.2
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 نحوه انتخاب چیدمان مناسب- 5.2.2 
فیلدهای چیده شده در گزارش را جابه جا ایجاد نمودیم، می توانیم ReportWizardبعد از اینکه یک گزارش را به روش 

 و1کنیم، اندازه آن ها را تغییر داده و فونت، رنگ و فرمت آن ها را مطابق سلیقه و نیاز خود تغییر دهیم.بههرای تغییههر چیههدمان

1 Layout

: انتخاب لیه برای گزارش5.2.2شکل 
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ویرایش گزارش، باید گزارش را در نمای طراحی نمایش دهیم.

 مشاهده می کنیم.۵:1جدول هر گزارش از قسمت های مختلفی تشکیل شده است که در 

توضیحاتناحیه

Page Header .این ناحیه در ابتدای هرصفحه گزارش چاپ می شود

   Group headerاین ناحیه برای گروه بندی گزارش به کار می رود و در
ابتدای هرگروه چاپ می شود.

Detailاین ناحیه، ناحیه تکرار شونده گزارش است که محتوای
گزارش را چاپ می کند.

Page Footer.این ناحیه در انتهای هر صفحه گزارش چاپ می شود

: نواحی مختلف یک گزارش5:1جدول 

ایجاد و ویرایش گزارش از طریق نمای طراحی- 5.3 
نحوه ایجاد گزارش- 5.3.1 

برای ایجاد گزارش از طریق نمای طراحی اعملیات زیر را انجام می دهیم:

 کلیک می کنیم. برروی Tasks می شویم در محیط Reportsوارد نمای .1

 باز می شود.آن را می بندیم.Add Fieldsپنجره .2
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فحه نمایشPropertiesدر سمت راست نمای طراحی پنجره .۳ رروی ص اهده ب  را مشاهده می کنیم.در صورت اعدم مش

 را انتخاب می کنیم.Peropertiesطراحی کلیک راست کرده و گزینه 

 را انتخاب می کنیم.Table گزینه Content type در قسمت Dataدر سربرگ .۴

 جدول مورد نظر را انتخاب می کنیم.Contentدر قسمت .۵

 باز می شود.فیلدهای مورد نظر را با دوبار کلیک به صفحه نمایش منتقل می کنیم.Add Fieldsپنجره .۶

با انجام ویرایش های مورد نیاز پنجره طراحی را می بندیم..۷

 کلیک می کنیم.Saveبرروی گزینه ی .۸

 نشان داده ایم. ۵.۳.1شکل همانطور که در 
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ویرایش گزارش- 5.3.2 
برای ویرایش یک گزارش اعملیات زیر را انجام می دهیم:

 می شویم.Reportsوارد نمای .1

 را انتخاب می کنیم.Editبرروی جدول مورد نظر کلیک راست کرده و گزینه .2

 نشههان۵.۳.2شکل در صفحه ی باز شده می توانیم اندازه متن، فیلد رنگ بندی و غیههره انجههام داد. همههانطور کههه در .۳

: مراحل انجام ایجاد گزارش از طریق نمای طراحی5.3.1شکل 

1
2

3

4
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داده ایم.

: ویرایش گزارش5.3.2شکل 
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آماده سازی و چاپ-  6 
پیش نمایش- 6.1 
نحوه نمایش فرم یا گزارش در پیش نمایش- 6.1.1 

هر گزارش یا فرم برای ارائه به دیگران ممکن است نیاز به چاپ داشته باشد که در اینصورت نیاز بههه آشههنایی بهها نحههوه

و پیش نمایش هست.1تنظیمات چاپ 

File>Printبرای مشاهده پیش نمایش گزارش یا فرم، وارد گزارش مهورد نظهر می شهویم و مسههیر   Previwاب  را انتخ

 استفاده می کنیم.Crtl+Shift+Oمی کنیم. ویا از کلیدهای میانبر 

 (واژه پرداز) داده شده است.FCDLتوضیحات کامل مربوط به بخش پیش نمایش چاپ در مهارت ششم آموزش دوره

تنظیمات چاپ- 6.2 
آشنایی با تنظیمات چاپ- 6.2.1 

پس آنکه یک شیء را در پنجره پیش نمایش چاپ مشاهده نمودیم، قبل از چاپ کردن آن شههیء بهههتر اسههت تنظیمههات

چاپ را انجام دهیم تا حاصل کار مطابق میل و سلیقه ما باشد.

آشنایی با تنظیمات چاپ در مهارت کار با واژه پرداز شراح داده  شده است.

توانایی تنظیمات چاپ- 6.2.2 

برای انجام تنظیمات مربوط به چاپ، اعملیات زیر را انجام می دهیم:

1 Print
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وارد گزارش مورد نظر می شویم..1

 نشان داده ایم.۶.2.1شکل  را انتخاب می کنیم. همانطور که در File>Printer Setting مسیر .2

 نشان داده ایم. ۶.2.2شکل  باز می شود. همانطور که در Printer Setupپنجره .۳

: باز کردن پنجره تنظیمات چاپ6.2.1شکل 
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لیست کشویی برای انتخاب چاپگر موجود برای چاپ گزارش می باشد.)1(

تنظیمات مربوط به چاپگر می باشد.)2(

اطلاعات چاپ را نمایش مي دهد.)۳(

تنظیمات مربوط به گزینه های انتخابی برای چاپ گزارش می باشد.)۴(

توضیحات کامل را در مهارت کار با واژه پرداز فراگرفته ایم.

: پنجره تنظیمات چاپ6.2.2شکل 

1 2

3

4
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:1منابع-  7 

1. http://www.libreoffice.org/get-help/documentation/
2. http://www.slideshare.net/bobmcdonald/libreoffice-training-presentation
3. http://learnlinuxandlibreoffice.org/
4. http://os4me.com/open-source-training/libreoffice/
5. http://www.open-of-course.org/courses/course/view.php?id=86
6.http://www.computer-pdf.com/office/127-libreoffice-4.0-writer-guide-word-processing-with-

style.html
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